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Chapter 1. Sterling Gentran:Server for RosettaNet Overview

About RosettaNet with Sterling Gentran:Server
RosettaNet is a consortium of computer manufacturers, electronics component
suppliers, and distributors focused on automating and improving the efficiency of
the supply chain within that industry by using standard electronic business
interfaces via Internet transport and XML technology.

RosettaNet defines a format for business processes, which include data formats
and flows using RosettaNet-defined transport methods and security. The
RosettaNet-defined processes serve as frameworks for business flows throughout
trading partner systems.

See the RosettaNet website for information about the RosettaNet consortium and
its standards. See the RosettaNet Implementation Framework (RNIF) message for
details about transport and security method requirements.

A Partner Interface Process (PIP) is a RosettaNet-defined business process designed
to be a framework for business flows between RosettaNet trading partners. IBM®

Sterling Gentran:Server® for Microsoft Windows for RosettaNet enables you to
modify PIPs according to your processing needs.

Sterling Gentran:Server for RosettaNet works with Sterling Gentran:Server to
enable you to configure processing for RosettaNet-compliant electronic business
processes. Sterling Gentran:Server for RosettaNet also enables you to monitor
RosettaNet processing activity.

Note:

v Sterling Gentran:Server for RosettaNet supports RNIF 1.1 and 2.0 messages.
v The MIME parts of all RNIF 2.0 outbound messages are base64 encoded.

The majority of the processing involved in a RosettaNet-compliant business process
falls within the scope of the Sterling Gentran:Server system. However,
RosettaNet-compliant processes are based on a service-to-service process and one
RosettaNet-compliant business process may involve multiple messages. Therefore,
Sterling Gentran:Server for RosettaNet enables you to configure and track the
following information:
v information about each message and its partner relationship
v the communications configuration for a process
v the status of the messages within the system

Sterling Gentran:Server for RosettaNet Components
You use the Sterling Gentran:Server for RosettaNet components to:
v Customize PIP properties according your needs and the requirements of your

trading partners.
v Track PIP instances (RosettaNet messages).
v View detailed information about a selected message.
v Start and stop the PIP Monitor service.
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v Send and receive RosettaNet messages and verify digital signatures.

This table describes the Sterling Gentran:Server for RosettaNet components.

Program Description

PIPLoader_UI.EXE The PIPLoader_UI.exe component is a Sterling Gentran:Server
for RosettaNet Server utility that will allow users to load
individual PIPs into the PIPDef_tb that are not available in
the standards. See The PIP Loader Utility for more
information.

PIPProfiler.EXE This is the PIP Profiler, which is a component of Sterling
Gentran:Server for RosettaNet that enables you to set up PIP
profiles for RosettaNet processing, and thus set business rules
by which PIPs will be executed and monitored with your
trading community.

The PIP Profiler enables you to modify PIP properties from
predefined RosettaNet PIP definitions. Then you can save the
new PIP profile in the PIPProfile_tb database table and reuse
it as a template for customizing other PIPs.
Note: For Sterling Gentran:Server for RosettaNet version 5.3,
the PIP Profiler enhances and replaces the PIP Decision Editor
from previous releases.

See the Using the PIP Profiler section for more information.

PIPViewer.EXE This is the PIP Instance Viewer, which is a component of
Sterling Gentran:Server for RosettaNet that allows you to
view all the RosettaNet documents and the details that were
in the Preamble, Delivery Header (for RNIF 2.0 messages
only), and Service Header of the message. This allows you to
see the completeness of PIPs as well as their status. The PIP
Instance Viewer enables you to:

v Identify the PIP to which a message belongs using the
preamble and service header information.

v Verify PIP status.

v Confirm detailed PIP information for a message.

See the Using the PIP Instance Viewer section for more
information.

PIPMonitorService.EXE This is the PIP Monitor, which tracks every PIP message,
verifies that messages are flowing through the system in
conformance with the business rules established in the PIP
Profiler, determines what the system response to the message
should be, and executes that response. PIP Monitor actions
include:

v sending alerts

v sending errors

v sending warnings

v resending a message

See The PIP Monitor for more information.
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Program Description

RNMgmtConsole.EXE This is the Sterling Gentran:Server RosettaNet Management
Console, which is the launching point for all other RosettaNet
Applications, including the:

v Partner Contact Information Manager

v PIP Profiler

v PIP Instance Viewer

v Security Profile Manager

This interface also enables you to start and stop the PIP
Monitor service and select whether you keep (rather than
discard) inbound message that are security violations or
would generate exceptions.

SCCertMgr.EXE This is the Security Profile Manager, which enables you to
administer both the public and private certificates required to
encrypt, decrypt, sign, and verify messages as they flow in
and out of Sterling Gentran:Server.
Note: The Security Profile Manager only resides on the
Sterling Gentran:Server Mailbox Server, and is responsible for
managing the digital certificate on that machine. The nature
of certificate management makes it impossible to remotely
administer these functions.

SCPartnerContactInfo.EXE The Partner Contact Information Manager enables you to
specify information about your enterprise and your partners’
enterprises, to ensure that the system can accurately process
RosettaNet signal and 0A1 messages.

Changes to Sterling Gentran:Server for RosettaNet
In addition to installing the RosettaNet components, the Sterling Gentran:Server for
RosettaNet installation program also modifies the core Sterling Gentran:Server
program. This enables Sterling Gentran:Server to provide the appropriate
functionality for RosettaNet customers.

The user interface modifications for Sterling Gentran:Server for RosettaNet are
located in the following subsystems:
v Archive Manager

See the Using Archive and Restore section for more information.
v Partner Editor

See the Using Partner Editor section for more information.
v During translation the interchange key is made available to the Application

Integration subsystem (MAPPER.EXE program) through the use of extended rules.
See the IBM Sterling Gentran:Server Application Integration User Guide for more
information on extended rules.

RosettaNet Management Console
The RosettaNet Management Console is the launching point for all other
RosettaNet Applications, including the:
v Partner Contact Information Manager
v PIP Profiler
v PIP Instance Viewer
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v Security Profile Manager

This interface also enables you to start and stop the PIP Monitor service and select
whether you keep (rather than discard) inbound message that are security
violations or would generate exceptions.

This diagram illustrates the RosettaNet Management Console.

This table describes the parts of RosettaNet Management Console.

Part Function

Partner Contact
Information Manager

Displays the Partner Contact Information Manager Dialog Box.

PIP Profiler Displays the PIP Profiler Browser.

PIP Instance Viewer Displays the PIP Instance Viewer Browser.

Security Profile
Manager

Displays the Security Profile Manager Browser.

PIP Monitor Service
Start/Stop

Enables you to stop or start the PIP Monitor service on the selected
controller.

Keep Mailbox
messages that are
security violations or
would generate
exceptions

Enables you to specify whether you want to keep inbound
messages that are security violations or that would generate
exceptions. The default is not selected, which indicates that all
traces of inbound messages that are security violations or that
generate exceptions are discarded.

The PIP Monitor
The PIP Monitor is a component of the Sterling Gentran:Server for RosettaNet that:
v Tracks every PIP message.
v Determines what the system response to the message should be.
v Executes that response.

The PIP monitor ensures that messages which are flowing through the system
conform to the business rules that you established through the PIP Profiler.
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PIP Monitor activity

As part of its PIP tracking process, the PIP Monitor sends alerts, errors, and
warnings to the Sterling Gentran:Server Audit Log. The PIP Monitor also resends
messages, as required (for example, if a response message was not received then
the PIP Monitor initiates a resend of the outgoing message). You configure PIP
specifications via the PIP Profiler, according to the trading partner and message,
and this configuration determines the PIP Monitor activities for each PIP.

Example Actions:

v When a PIP message enters the system, the PIP Monitor uses the customized PIP
profile that you configured with the PIP Profiler to ascertain which messages to
send in response to the message.

v The PIP Monitor resends the message automatically based on the values
specified when you set up the PIP. When you create a PIP profile, you set a time
allotment in which the response or acknowledgement for that message must be
received. Then if the allotted time expires, the PIP Monitor resends the message.
If the PIP Monitor reaches the maximum retry count, it sends an error message
to the Sterling Gentran:Server Audit Notification system. Prior to initiating the
resend, the PIP Monitor changes the status in the PIPTrack_tb database table to
"R" so the Delivery Agent knows to treat the document as a resend.

v If a resend does not correct the issue or a resend is no longer appropriate, the
PIP Monitor places the PIP in a state of "Error" and initiates an 0A1 Notification
of Failure PIP. You can also specify that if a PIP is approaching an error status
then the PIP Monitor sets it to "Warning," based on the warning timeout
threshold

See the Using the PIP Profiler section for more information about creating PIP
profiles. See PIP Monitor Error Messages for information about the error messages
the PIP Monitor sends to the Sterling Gentran:Server Audit Log.

Managing the PIP Monitor

The PIP Monitor does not have a Sterling Gentran:Server user interface. It is a
service (RosettaNet Server PIP Monitor) managed through the Microsoft Windows
Control Panel Services application (for Microsoft Windows) or the Services MMC
snap-in.

Note: Any other information the PIP Monitor communicates is placed into the
Sterling Gentran:Server Audit Log or the Microsoft Windows Event Log.

Viewing PIP Monitor messages

The PIP Monitor sends messages to the Audit Notification System and you use the
Sterling Gentran:Server Audit Log to view PIP Monitor messages.

See Using the Audit Log in the IBM Sterling Gentran:Server for Microsoft Windows
Administration Guide for more information on that Sterling Gentran:Server feature.

The PIP Loader Utility
The PIPLoader_UI.exe component is a Sterling Gentran:Server for RosettaNet
Server utility that allows users to load individual PIPs into the PIPDef_tb that are
not available in the standards.
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Using the PIP Loader Utility User Interface

The PIP Loader Utility uses the Sterling Gentran:Server Mailbox Server DSN
settings to logon to the database and insert the PIP information. If Sterling
Gentran:Server is installed on an Oracle database, the "Oracle Database" check box
must be selected before a PIP can be inserted into the database. This will prompt
the user for the Oracle username and password.

All fields in the PIPDef_tb must be populated with a value when entering a new
PIP entry. The PIP Loader Utility will not insert the values if any of the fields are
not populated with a valid value.

The Implementation Process
This table lists the tasks you need to complete to implement Sterling
Gentran:Server for RosettaNet.

Stage Process

1 Install Sterling Gentran:Server for RosettaNet. See the Installation Guide for more
information.

2 For each of your trading partners, create inbound and outbound relationships
for each message in the PIPs you are exchanging. See the Using Partner Editor
section for more information.

3 Create a PIP profile for each PIP you are exchanging. See the Using the PIP
Profiler section for more information.

4 Configure partner contact information for each one of your trading partners. See
Creating a Partner Contact for more information.
Note: You must enter partner contact information before the system can process
RosettaNet Receipt Acknowledgements and Exceptions.

5 Load the RosettaNet message standards.

6 Configure inbound and outbound mapping information. See the Configuring
Maps for Use with RosettaNet section for more information.

7 If necessary, configure security profile information. See the Using the Security
Profile Manager and Other Communications Tasks section for more information.

8 Create an inbound mailbox, an outbound mailbox, and configure the RosettaNet
Delivery Agent. See the Using the Security Profile Manager and Other
Communications Tasks section for more information.

9 Test the exchange of a PIP with your trading partner.

10 Determine whether you want to keep inbound messages that are security
violations or generate exceptions. If you do, access the RosettaNet Management
Console and select "Keep Mailbox message that are security violations or would
generate exceptions".
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Chapter 2. Using Partner Editor with Sterling Gentran:Server
for RosettaNet

About Partners and the Partner Editor
The Partner Editor allows you to define, edit, and delete all partner relationship
information for your company and all of your trading partners. Partner
relationships allow you to send and receive data to and from your trading
partners.

The Partner Editor also allows you to use an internal system partner (Internal
System User) to define your company to the system.

See Using Partners in the IBM Sterling Gentran:Server for Microsoft Windows User
Guide for more information on using Partner Editor outside the scope of Sterling
Gentran:Server for RosettaNet.

A partner profile begins with a partner definition. The partner definition contains
the basic information that the system needs before you define the rest of the
partner profile. You need to create a partner definition for each partner with whom
you are going to exchange data.

To complete the partner profile, you need to define an inbound and an outbound
relationship. You need to create an inbound and outbound relationships for each
partner with whom you are going to exchange data.

Partner Contact Information Manager

The Partner Contact Information Manager enables you to specify information
about your enterprise and your partners’ enterprises, to ensure that the system can
accurately process RosettaNet signal and 0A1 messages.

Note: You must enter partner contact information before the system can process
RosettaNet Receipt Acknowledgements and Exceptions.

Defining a Partner Profile Process

The following table describes the partner profile creation process.

Stage Description

1 Create the partner definition. See Creating a RosettaNet Partner Definition.

2 Create the inbound relationship. See About RosettaNet Inbound Relationships.

3 Create the outbound relationship. See About RosettaNet Outbound
Relationships.

4 To use a cross-reference or lookup table with the partner relationship to
supplement or convert data you enter or receive inbound, see Creating a Table
in the IBM Sterling Gentran:Server for Microsoft Windows User Guide for more
information.

5 To use locations to contain address- and contact-related information about the
partner, see Creating Partner Locations in the IBM Sterling Gentran:Server for
Microsoft Windows User Guide for more information.
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Stage Description

6 To specify information about your enterprise and your partners’ enterprises,
to ensure that the system can accurately process RosettaNet signal and 0A1
messages, see Creating a Partner Contact for more information.

Partner Settings

Partner Editor Dialog Box
Partner Editor enables you to define, edit, and delete all partner information for
your company and all of your trading partners.

This diagram illustrates the Partner Editor dialog box.

This table describes the parts of the Partner Editor dialog box.

Part Function

Select a Partner Displays the list of partner profiles.

Copy Displays the Partner Copy Dialog Box, which allows you to copy a
partner profile.

Import Displays the Import File Select Dialog Box, which allows you to
import a partner profile.

Export Displays the Export File Build Dialog Box, which allows you to
export a partner profile.

Exit Exits the Partner Editor dialog box.

Edit Displays the Partner Definition (New/Edit) Dialog Box for the
selected partner.
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Part Function

New Displays the Partner Definition (New/Edit) Dialog Box, which
allows you to create a new partner definition.

Delete Removes the selected partner profile from the system.

Inbound Displays the Inbound Relationship Dialog Box for the selected
partner.

Outbound Displays the Outbound Relationship Dialog Box for the selected
partner.

Tables Displays the Partner Tables Dialog Box for the selected partner.

Locations Displays the Location Select Dialog Box for the selected partner.

Partner Definition Dialog Box
The Partner Definition dialog box enables you to create a new partner definition
and allows you to edit a selected, previously defined partner definition.

This diagram illustrates the Partner Definition - New dialog box.

Note: See the IBM Sterling Gentran:Server for Microsoft Windows Communications
User Guide for more information.

This table describes the parts of the Partner Definition dialog box.

Part Function

Profile ID Specifies a unique identifier for the selected partner.

Name Specifies a unique name for the partner.
Note: Make this name as descriptive as possible because this is the
name displayed in the partner selection list.

EDI Code Specifies the EDI identifier for this partner. The system uses this
value during inbound processing to select the correct trading
partner definition.

Application Code Specifies an application code used to identify this partner. The
system uses this value during outbound import processing to select
the correct trading partner definition.

Default Mailbox Specifies a default mailbox to use to identify this partner for
non-RosettaNet EDI relationships.

Default E-mail
Address

Specifies a default e-mail address to use to identify this partner for
non-RosettaNet EDI relationships.
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Part Function

New Mailbox Displays the Create New Mailbox wizard, which allows you to
create a new mailbox.

Edit Mailbox Displays the Mailbox Properties dialog box, which allows you to
edit the mailbox.

Partner Contact Information Manager Dialog Box
The Partner Contact Information Manager enables you to specify information
about your enterprise and your partners’ enterprises, to ensure that the system can
accurately process RosettaNet signal and 0A1 messages.

Note: You must enter partner contact information before the system can process
RosettaNet Receipt Acknowledgements and Exceptions.

This diagram illustrates the Partner Contact Information Manager dialog box.

This table describes the parts of the Partner Contact Information Manager dialog
box.

Part Function

Select a Partner Displays the list of partner profiles.

EDI Code Displays the EDI Code for the selected partner.

From Contact Name Displays the contact name for the selected partner.

From E-Mail Address Displays the E-mail address for the selected partner.

From Telephone
Number

Displays the telephone number for the selected partner.

From Fax Number Displays the fax number for the selected partner.

From Global Supply
Chain Code

Specifies the code for the global supply chain code. The applicable
RosettaNet codes are listed in the Service Header Guideline.

From Global Partner
Classification Code

Specifies the classification code for the "from" partner. The
applicable RosettaNet codes are listed in the Service Header
Guideline.

To Contact Name Specifies the name of the "to" contact.
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Part Function

To E-Mail Address Specifies the E-Mail address of the "to" contact.

To Telephone Number Specifies the telephone number of the "to" contact.

To Fax Number Specifies the fax number of the "to" contact.

To Global Supply
Chain Code

Specifies the code for the global supply chain code. The applicable
RosettaNet codes are listed in the Service Header Guideline.

To Global Partner
Classification Code

Specifies the classification code for the "to" partner. The applicable
RosettaNet codes are listed in the Service Header Guideline.

Add Displays the Add Contact Dialog Box, which allows you to add a
new partner contact.

Edit Displays the Edit Contact Dialog Box, which allows you to add a
new partner contact.

Delete Removes the selected partner contact from the system.

Import Displays the Filename for Partner Contact Information Import
Dialog Box, which allows you to import a partner contact.

Export Displays the Filename for Partner Contact Information Export
Dialog Box, which allows you to export a partner contact.

Add and Edit Contact Dialog Boxes
The Add Contact and Edit Contact dialog boxes enables you to add a partner
contact or edit an existing partner contact in the Partner Contact Information
Manager.

This diagram illustrates the Add Contact dialog box. (The Edit Contact dialog box
looks the same as the Add Contact dialog box.)

This table describes the parts of the Add Contact and Edit Contact dialog boxes.

Part Function

EDI Code Contains a list of the EDI Codes already entered into the Sterling
Gentran:Server Partner Editor so you can specify which EDI code
to use for this partner contact.

From Contact Name Specifies the name of the "from" contact.

From E-Mail Address Specifies the E-Mail address of the "from" contact.
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Part Function

From Telephone
Number

Specifies the telephone number of the "from" contact.

From Fax Number Specifies the fax number of the "from" contact.

From Global Supply
Chain Code

Specifies the code for the global supply chain code. The applicable
RosettaNet codes are listed in the Service Header Guideline.

From Global Partner
Classification Code

Specifies the classification code for the "from" partner. The
applicable RosettaNet codes are listed in the Service Header
Guideline.

To Contact Name Specifies the name of the "to" contact.

To E-Mail Address Specifies the E-Mail address of the "to" contact.

To Telephone Number Specifies the telephone number of the "to" contact.

To Fax Number Specifies the fax number of the "to" contact.

To Global Supply
Chain Code

Specifies the code for the global supply chain code. The applicable
RosettaNet codes are listed in the Service Header Guideline.

To Global Partner
Classification Code

Specifies the classification code for the "to" partner. The applicable
RosettaNet codes are listed in the Service Header Guideline.

Creating a RosettaNet Partner Definition
The partner definition contains the basic information about that partner that the
system needs before you define the rest of the partner profile.

Before you begin

Before setting up a new partner definition, you must have the following
information.
v The communication profile name you use to communicate with this partner
v The EDI code for this partner
v The application code used to identify this partner in the import file

This application code is needed only if the messages are processed using the file
Import facility.

About this task

Use this procedure to create a new partner definition.

Procedure
1. From the Windows Start menu, select Programs > Gentran Server > Gentran

Server.
2. Select Tools > Partner Editor.

The system displays the Partner Editor Dialog Box.
3. Click New.

The system displays the Partner Definition (New/Edit) Dialog Box.
4. In the Profile ID box, type a unique alphanumeric Profile ID for this partner.

Note: Do not use special characters.
5. In the Name box, type the partner name.
6. In the EDI Code box, type the EDI identifier for this partner.
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Note: The system uses this identifier during inbound processing, to select the
correct partner.

7. If necessary, in the Application Code box, type an application code to identify
this partner.

Note: The system uses this identifier during outbound import processing, to
select the correct partner.

8. After you enter all the partner definition information, click Save.
9. Click Exit to return to the Partner Editor dialog box.

Note: To complete the partner profile you need to define an inbound and
outbound relationship for this partner.

Editing a Partner Profile
The partner definition contains the basic profile information about that partner to
which the system associates the rest of that partner’s records.

About this task

Use this procedure to edit a partner profile.

Procedure
1. From the Windows Start menu, select Programs > Gentran Server > Gentran

Server.
2. Select Tools > Partner Editor.

The system displays the Partner Editor Dialog Box.
3. Select the appropriate partner from the Select a Partner list and click Edit.

The system displays the Partner Definition (New/Edit) Dialog Box for that
partner.

4. Make the necessary changes and click Save.

Notes:

v You can also edit other aspects of a partner relationship (such as inbound
and outbound relationships) by clicking the appropriate button (Inbound or
Outbound) on the Partner Editor dialog box.

v You are not able to edit any boxes that are unavailable; these are the "keys"
to the relationship. In this case, you must create a new inbound or outbound
relationship for that partner.

The system returns to the Partner Editor dialog box.

Deleting a Partner Profile
The partner definition contains the basic profile information about that partner to
which the system associates the rest of that partner’s records.

About this task

Use this procedure to delete a partner profile.

Procedure
1. From the Windows Start menu, select Programs > Gentran Server > Gentran

Server.
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2. Select Tools > Partner Editor.
The system displays the Partner Editor Dialog Box.

3. Select the appropriate partner from the Select a Partner list and click Delete.

Important: When you delete a partner relationship, the messages and
interchanges associated with that partner are also deleted.
You are prompted to confirm the deletion.

4. If any messages or interchanges exist for a partner you choose to delete, you
are warned before the actual deletion.

5. Click Yes to delete the selected partner profile.
The partner profile and all associated records are deleted.

Creating a Partner Contact
You must enter partner contact information before the system can process
RosettaNet Receipt Acknowledgements and Exceptions.

About this task

Use this procedure to create a partner contact.

Procedure
1. From the Windows Start menu, select Programs > Gentran Server > Gentran

RosettaNet Management Console.
The system displays the RosettaNet Management Console.

2. Click Partner Contact Information Manager.
The system displays the Partner Contact Information Manager Dialog Box.

3. Click Add.
The system displays the Add Contact Dialog Box.

4. From the EDI Code list, select the EDI Code for the partner for which you want
to create contact information.

5. Complete the remaining boxes.
6. Click OK.

Saves the partner contact information and exits the dialog box.

Editing Partner Contact Information
About this task

Use this procedure to edit partner contact information.

Procedure
1. From the Windows Start menu, select Programs > Gentran Server > Gentran

RosettaNet Management Console.
The system displays the RosettaNet Management Console.

2. Click Partner Contact Information Manager.
The system displays the Partner Contact Information Manager Dialog Box.

3. Select the partner contact information you wish to change and click Edit.
The system displays the Edit Contact Dialog Box.

4. Modify the necessary information.
5. Click OK.
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Saves the modified partner contact information and exits the dialog box.

Deleting a Partner Contact
About this task

Use this procedure to delete a partner contact and all associated records.

Procedure
1. From the Windows Start menu, select Programs > Gentran Server > Gentran

RosettaNet Management Console.
The system displays the RosettaNet Management Console.

2. Click Partner Contact Information Manager.
The system displays the Partner Contact Information Manager Dialog Box.

3. From the list, select a partner contact and click Delete.
You are prompted to confirm the delete.

4. Click Yes to confirm the delete.

Importing a Partner Contact
To use this function you must have already exported a partner contact to an XML
file.

About this task

Use this procedure to import a partner contact.

Procedure
1. Verify that the PartnerContactInfo_tb.dtd file is located in the same directory

as the XML file you wish to import. If this DTD file is not located in the same
directory, copy it there.

Note:

v This DTD file is originally installed in the GENSRVNT\BIN directory.
v The PartnerContactInfo_tb.dtd file must be located in the same directory as

the XML file to be imported because it is used to verify that the XML file
contains valid partner contact information.

2. From the Windows Start menu, select Programs > Gentran Server > Gentran
RosettaNet Management Console.
The system displays the RosettaNet Management Console.

3. Click Partner Contact Information Manager.
The system displays the Partner Contact Information Manager Dialog Box.

4. Click Import.
The system displays the Filename for Partner Contact Information Import
Dialog Box.

5. Enter the name or navigate to the partner contact.
6. Click Open.

The system confirms that the import is complete.
7. Click OK to complete the import process.
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Exporting a Partner Contact
This function enables you to export partner contact information to an XML file.

About this task

Use this procedure to export a partner contact.

Procedure
1. From the Windows Start menu, select Programs > Gentran Server > Gentran

RosettaNet Management Console.
The system displays the RosettaNet Management Console.

2. Click Partner Contact Information Manager.
The system displays the Partner Contact Information Manager Dialog Box.

3. Select the partner contact you wish to export and click Export.
The system displays the Filename for Partner Contact Information Export
Dialog Box.

4. Enter or select a name for the export file.

Note: The system automatically prompts you with the .XML extension.
5. Click Save to export the partner.

The system confirms that the export is complete.
6. Click OK to complete the export process.

Inbound Settings

Inbound Relationship Dialog Box
Inbound relationships define the parameters the system needs to receive a message
from a trading partner. The Inbound Relationship dialog box controls other
subordinate dialogs which allow you to define everything that is necessary to
establish the relationship.

You are required to specify exactly which message is to be received. You also
define which translation objects are used to define any turnaround messages,
export rules, or printing requirements.

This diagram illustrates the Inbound Relationship dialog box with the Advanced
options appended.
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This table describes the parts of the Inbound Relationship dialog box.

Part Function

Relationship Description Specifies the existing inbound relationships.

Standard Specifies the standard to be used in this relationship. Valid
values:

v A - TRADACOMS

v C - CII

v D - NCPDP

v E - EDIFACT

v O - ODETTE

v P - OTHER

v R - ROSETTANET

v T - TDCC

v U - UCS

v V - VDA

Note: Only standards for which you have existing translation
objects are displayed. This box cannot be changed for an
existing relationship. Selection of this box is mandatory.

Version Specifies the standard version to be used in this relationship.
Note: Only versions of the selected standard for which you
have existing translation objects are displayed. If this box is
changed for an existing relationship, all of the information
defined below it is cleared and must be reselected. Selection of
this box is mandatory.
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Part Function

Transaction Set Specifies the message to be used in this relationship.
Note: Only messages for the selected version (for which you
have existing translation objects) are displayed. If this box is
changed for an existing relationship, all of the information
defined below it is cleared and must be reselected. Selection of
this box is mandatory.

Release Specifies the release number to be used in this relationship.
Note: Only releases for the selected message for which you
have existing translation objects are displayed. This box is
currently only used for messages defined in the TRADACOMS
standard. Selection of this box is mandatory for all
TRADACOMS messages.

Transaction is an
acknowledgement

Specifies that the transaction defined in this partner relationship
is an acknowledgement.

Groups Accesses the Inbound Group Select Dialog Box.

Interchanges Accesses the Inbound Interchange Select Dialog Box.

New Accesses the New Inbound Relationship dialog box, which
allows you to create a new relationship.

Delete Removes the specified inbound relationship from the system.

Translation Accesses the Inbound Translation Object Dialog Box.

Advanced Toggles the display of the advanced options.

Sequence Checking Specifies whether the system will use sequence checking and
whether that sequence checking is incremental or chronological.
You can also indicate that the system must check for duplicate
control numbers.

v None - sequence checking will not be used

v Duplicate - check for duplicate control numbers
Note: Duplicate documents are not processed but outbound
receipts are still generated and sent.

v Incremental - the control number must be one greater than
the last number

v Chronological - the control number must be greater than the
last number

Last Used Control
Number

Specifies a value that is used to sequence check the next
transaction set control number or message reference. This value
is replaced with the sequence number of the last message
received. This box is initially set to zero.
Note: This box is inactive if Sequence Checking is None.

Duplicate Documents Indicates whether the system will check for duplicate message
names.

Skip Compliance Check Indicates whether you want the system to compliance check the
messages for this relationship.
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Part Function

Generate
Acknowledgements

Instructs the system to generate a functional acknowledgement
to this trading partner when you receive the message defined in
this relationship. The default value for this box is No (do not
generate an acknowledgement).

v No - do not generate acknowledgements

v Yes - No Error Detail - generate acknowledgements without
error detail

v Yes - With Error Detail - generate acknowledgements with
error detail

Note: This entire box is inactive if the message in this
relationship is an acknowledgement.

Test Indicator Specifies whether you want the system to treat the messages
that you receive from this trading partner as test or production.

Acknowledgement
Processing

Indicates whether acknowledgement reconciliation will occur
during the inbound break session (Immediate) or during its
scheduled interval (Deferred). The default is Deferred.

Inbound Translation Object Dialog Box
The Inbound Translation Objects dialog box is used to specify which translation
objects are used to process the data defined by this relationship.

This table lists the inbound translation levels (hierarchically, from the lowest level
up).

Part Function

Document Validate the message against the specified translation object to
verify if the message is compliant with the standard, and
translate from the message format to print or application
format.

Transaction Remove the enveloping around a single message.

Group Remove the enveloping around a set of related messages (the
messages do not have to be the same type).

Interchange Remove the enveloping around groups that are destined for
the same trading partner.

Note: See the IBM Sterling Gentran:Server for Microsoft Windows Communications
User Guide for more information.

This diagram illustrates the Inbound Translation Object dialog box with the
Advanced options appended.
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This table describes the parts of the Inbound Translation Object dialog box.

Part Function

Turn Around/Auto Displays all of the turnaround message options. When a message is
received, the turnaround message created is the natural response
message that contains as many elements from the received message
as possible.
Note: Select Auto if you want the defined turnaround process to be
automatic. If Auto is not selected, the received message will remain in
the In Documents until it is selected for processing.

Export File/Auto Displays all registered Export translation objects relative to the
Standard, Version, Transaction Set and Release defined by this
relationship. This allows you to specify that when a message is
received, it is exported into an output file.
Note:

v Select Auto if you want the export file created automatically upon
receipt of the message. If Auto is not selected, the received message
will remain in the In Documents until it is selected for processing.

v If the Export File Name is defined for this relationship, each
document can be exported individually to a unique file. If you use
formatting characters in the file name, the document key changes
for each document that is exported, the Process ID stays the same
(for all documents exported from the same interchange), and the
unique ID changes. Therefore, using the "document key" and
"unique ID" special characters (defined below), a unique file name
can be derived.
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Part Function

Print Displays all of the print translation objects registered with the system
for the Standard, Version, Transaction Set, and Release defined by the
relationship. The selected translation object is used to print messages
received from this partner.

Export File Name Specifies the name of the file to be created or appended to as a result
of performing an export operation. This file name can contain a mix
of regular characters and formatting characters that are replaced by
the translator with the runtime value they represent.

The following formatting characters are supported:

v %y (two-digit year)

v %Y (four-digit year)

v %m (abbreviated month name)

v %M (month as a decimal number)

v %d (abbreviated weekday name)

v %D (day of the month as a decimal number)

v %H (hour in 24-hour format)

v %N (minutes)

v %S (seconds)

v %K (message key)

v %P (process identifier)

v %U (unique number derived using the current time, export
filename, process identifier, and the rand() function)

Note: The runtime file name is generated once per export.

The following is an example of a runtime file name using formatting
characters:

d:\GENSRVNT\exports\dockey%Kprocid%Puniqueid%U.dat

Export to Mailbox Checking this box invokes the "Export to Mailbox" function, which
allows the output of an inbound translation to be delivered back to
the Mailbox Server Manager. This allows the Mailbox Server Manager
to act as a message broker to be responsible for delivering the data to
its final destination.
Note: If you specified the Export File Name, it is still valid and will
become the Attachment Filename. Formatting characters are still valid
for the filename and could cause multiple attachments to be created if
document key is used. For example, if the following filename is used
d:\gensrvnt\exports\dockey%Kprocid%Puniqueid%U.dat, an
attachment is created for each document because the document key
creates a unique name for each document processed.

Use Partner Default
Mailbox and E-Mail
Address

Checking this box specifies that the output of the inbound translation
is exported to the default mailbox and E-mail address configured for
this partner.

Recipient Mailbox Contains a list of mailboxes so you can select the mailbox to which
the output of an inbound translation will be delivered.

New Mailbox Displays the Create New Mailbox wizard, which allows you to create
a new mailbox.

Recipient E-mail
Address

Contains the E-mail address to which the output of an inbound
translation will be delivered.

Edit Mailbox Displays the Create New Mailbox wizard, which allows you to edit
the mailbox.
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Part Function

Content
Type/SubType

Contains the content type/sub type of the message containing the
output of the inbound translation. See the IBM Sterling Gentran:Server
for Microsoft Windows Communications User Guide for more
information.

Application ID Specifies the application identifier that indicates the destination of the
messages

Application Alias
Value

Defines criteria for this relationship definition that is used instead of
another relationship definition, during the application import
function.
Note: This box will only be used if you receive translation objects
that are defined to use the Application Alias Value.

Import Contains other translation objects associated with the relationship,
giving you the capability to change the system behavior at the
message translation level. This allows you to use translation objects
that are as partner-specific as required and/or perform as many
functions as required.
Note: You will select a translation object from the Import list if you
have created a specific import translation object for this relationship
and if you want to change the way the system behaves for this
partner relationship. Import translation objects may not be
appropriate for an Inbound Relationship.

Data Entry Contains other translation objects associated with the relationship,
giving you the capability to change the system behavior at the
message translation level. This allows you to use translation objects
that are as partner-specific as required and/or perform as many
functions as required.
Note: You will select a translation object from the Data Entry list if
you have created a specific data entry translation object for this
relationship and if you want to change the way the system behaves
for this partner relationship (i.e., if you want to change the formatted
view of Inbound data).

Transaction Contains other translation objects associated with the relationship,
giving you the capability to change the system behavior at the
message translation level. This allows you to use translation objects
that are as partner-specific as required and/or perform as many
functions as required.
Note: You will select a translation object from the Transaction list if
you have created a specific Transaction Break translation object for
this relationship and if you want to change the way the system
behaves for this partner relationship.
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Part Function

Acknowledge Contains other translation objects associated with the relationship,
giving you the capability to change the system behavior at the
message translation level. This allows you to use translation objects
that are as partner-specific as required and/or perform as many
functions as required.
Note: You will select a translation object from the Acknowledge list if
you have created a specific translation object for this relationship and
if you want to change the way the system behaves for this partner
relationship.

When the system reconciles an acknowledgement, it maps the
acknowledgement to an internal file and then processes it. If you
need the system to process acknowledgements differently, you should
select an additional translation object from the Acknowledge list.

If the message is an acknowledgement and you choose an
Acknowledge additional translation object, the system will use the
additional translation object in place of the export translation object
for acknowledgement reconciliation.

Inbound Group Select Dialog Box
The Inbound Group Select dialog box is used to select an existing functional group
definition to be associated with this relationship. It can also be used to initiate the
definition of a new functional group or to modify or delete an existing definition.
The groups available to you are determined by the version you selected on the
Inbound Relationship dialog.

Note: Functional groups are required for ANSI X12, TDCC, and UCS standards,
optional for RosettaNet, EDIFACT, and ODETTE, and not specified for
TRADACOMS.

This diagram illustrates the Inbound Group Select dialog box.

This table describes the parts of the Inbound Group Select dialog box.

Part Function

Groups Displays all of the functional group definitions that are established
for this trading partner.

Select Selects the functional group to use with this relationship.
Note: Select <none> if the standard you are using does not require
groups and you do not want to use one.
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Part Function

New Displays the Inbound Group Entry Dialog Box, which allows you
to create a new group.

Edit Displays the Inbound Group Entry Dialog Box, which allows you
to edit the selected group.

Delete Removes the selected group from the system.

Inbound Group Entry Dialog Box
The Inbound Group Entry dialog box is used to specify a functional group
definition.

This diagram illustrates the Inbound Group Entry dialog box with the Advanced
options appended.

This table describes the parts of the Inbound Group Entry dialog box.

Part Function

Description Contains the name of the functional group description.

Standard Displays the standard the system is using for this relationship
definition.

Version Displays the version of the standard the system is using for this
relationship.

Functional Group ID Defines the identification of the functional group specified. These
identification boxes are defined by the appropriate standard group
to categorize messages. The standard defines which functional
group ID should be used with each message type. This is a
mandatory box.

24 IBM Sterling Gentran:Server for Windows: RosettaNet User Guide



Part Function

Sequence Checking Specifies whether inbound sequence checking is used and whether
the type of sequence checking is incremental or chronological. You
can also indicate that the system must check for duplicate control
numbers.

v None - sequence checking will not be used

v Duplicate - check for duplicate control numbers

v Incremental - the control number must be one greater than the
last number

v Chronological - the control number must be greater than the last
number

Note: If the system detects duplicate control numbers or detects
incremental or chronological control numbers that are out of
sequence, those messages are stored in the ?In Documents.

Last Used Group
Control Number

Specifies a value that the system will use to sequence check the
group control number. The number is replaced by the group
control number that the system receives. This value is initially set
to zero.

Acknowledge Group Instructs the system to send a functional acknowledgement to this
trading partner when you receive the group defined in this
relationship. The default value for this box is deselected (do not
expect an acknowledgement).
Note: This check box is inactive if the message is an
acknowledgement.

Ack Translation Set ID Contains the acknowledgement that you want generated for this
group.

Group Transl. Obj. Allows you to select a partner-specific Group Break Map
translation object if this trading partner group deviates from the
normal system behavior. You will select a translation object from
this list if you want the system to perform partner-specific
grouping.
Important: We strongly recommend that you do not change the
translation objects in the Group Transl. Obj. and Acknowledge
Transl. Obj. lists, unless you have a specific reason for doing so.

Acknowledge Transl.
Obj.

Contains an acknowledgement break map if one exists on the
system.
Note: You will select a translation object from the Acknowledge
Transl. Obj. list if you have created a specific translation object for
this relationship and if you want to change the way the system
behaves for this partner group. When the system reconciles an
acknowledgement, it maps the acknowledgement to an internal file
and then processes it. If you need the system to process
acknowledgements differently, you should select an additional
translation object from the Acknowledge list.
Important: We strongly recommend that you do not change the
translation objects in the Group Transl. Obj. and Acknowledge
Transl. lists, unless you have a specific reason for doing so.

Inbound Interchange Select Dialog Box
The Inbound Interchange Select dialog box is used to select an existing interchange
definition to be associated with this relationship. You can also use it to initiate the
definition of a new interchange or to modify or delete an existing definition. The
interchanges available to you are determined by the version you selected on the
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Inbound Relationships dialog. Interchanges are required for EDIFACT, ODETTE,
TRADACOMS, and UCS, and optional for RosettaNet, ANSI X12 and TDCC.

This diagram illustrates the Inbound Interchange Select dialog box.

This table describes the parts of the Inbound Interchange Select dialog box.

Part Function

Interchanges Displays all of the Interchange definitions that have been
established for this trading partner.

Select Selects the indicated interchange to be used with this relationship.
Note: Select <none> if the standard you are using does not require
interchanges and you do not want to use one.

New Displays the Inbound Interchange Entry Dialog Box, which allows
you to create a new interchange.

Edit Displays the Inbound Interchange Entry Dialog Box, which allows
you to edit the selected interchange.

Delete Removes the selected interchange from the system.

Inbound Interchange Entry Dialog Box
The Inbound Interchange Entry dialog box is used to specify a new interchange
definition.

This diagram illustrates the Inbound Interchange Entry dialog box with the
Advanced options appended.
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This table describes the parts of the Inbound Interchange Entry dialog box.

Part Function

Description Contains the name of the interchange description.

Standard Displays the standard the system is using for this relationship
definition.

Version Displays the version of the standard the system is using for this
relationship.

Interchange ID Defines the type of interchange you specified. The standard defines
which interchange ID should be used with each standard. This is a
mandatory box.

Sequence Checking Specifies whether or not the system will use sequence checking
and whether the sequence checking is incremental or chronological.
You can also indicate that the system must check for duplicate
control numbers.

v None - sequence checking will not be used

v Duplicate - check for duplicate control numbers

v Incremental - the control number must be one greater than the
last number

v Chronological - the control number must be greater than the last
number

Note: If the system detects duplicate control numbers or detects
incremental or chronological control numbers that are out of
sequence, those messages are stored in the ?In Documents.

Last Used Control
Number

Specifies a value that is used to sequence check the next
interchange control number. The number is replaced by the control
number on the last interchange received. This box is initially set to
zero.
Note: This box is inactive if Sequence Checking is None.

Acknowledge
Interchange

Instructs the system to send a functional acknowledgement to this
trading partner when you receive the interchange set defined in
this relationship. The default value for this box is deselected (do
not expect an acknowledgement).

Ack Translation Set ID Specifies the acknowledgement that you want the system to
generate for this interchange.
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Part Function

Interchange Transl.
Obj.

Specifies a partner-specific Interchange Break Map translation
object if this trading partner interchange deviates from the normal
system behavior. You will select a translation object from this list if
you want the system to perform partner-specific interchanging.
Important: We strongly recommend that you do not change the
translation objects in the Interchange Transl. Obj. and Acknowledge
Transl. Obj. lists, unless you have a specific reason for doing so.

Acknowledge Transl.
Obj.

Contains an acknowledgement break map if one exists on the
system.

You select a translation object from the Acknowledge Transl. Obj.
list if you have created a specific translation object for this
relationship and if you want to change the way the system behaves
for this partner interchange. When the system reconciles an
acknowledgement, it maps the acknowledgement to an internal file
and then processes it. If you need the system to process
acknowledgements differently, you should select an additional
translation object from the Acknowledge list.
Important: We strongly recommend that you do not change the
translation objects in the Interchange Transl. Obj. and Acknowledge
Transl. Obj. lists, unless you have a specific reason for doing so.

About RosettaNet Inbound Relationships
To correctly receive and process information from a trading partner, you must have
an appropriate inbound relationship established that defines the parameters
needed to receive data files from that partner. Each inbound relationship defines
which business messages are received from a partner.

You must set up several parameters that are used to create an inbound
relationship. These parameters tell the system the following information:
v The type of data that is received
v The criteria the system uses to validate the information it receives
v The functional groups and interchanges in which you expect to receive the

messages
v Which receipt acknowledgement translation object should be used

Translation Objects

Each inbound relationship must have one or more associated inbound translation
objects. These translation objects determine how the received data is processed.
You need to specify which translation objects are used to define the rules for
exporting, printing, and creating turnaround messages. At a minimum, one
translation object must be available.

Note: If this relationship requires a new translation object, you must register that
translation object with the system before creating the inbound relationship. See
How to Register a New Translation Object in the IBM Sterling Gentran:Server for
Microsoft Windows User Guide for instructions on how to register translation objects.

Inbound Groups and Interchanges

For RosettaNet, you must define or select an inbound interchange and inbound
functional group before the system allows you to complete the setup of an
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inbound relationship. The inbound functional group defines the format of the
functional group and the parameters that should be used to verify it. The inbound
interchange defines the format of the interchange and the parameters that should
be used to verify it.

Note: If you do not want to use an optional functional group or interchange you
must still select <none> from the appropriate dialog box to alert the system that
you are not using a group.

Before you Begin

Before setting up an inbound relationship, you must know the following
information to plan the implementation of this partner:
v The EDI standard that you expect from this trading partner (RosettaNet).
v The standard version that you expect from this trading partner (1.1 or 2.0 for

RosettaNet).
v The code for the message you expect from this trading partner (for example,

Purchase Order Request).
v The type of functional group and interchange the message is wrapped in when

it is received from this partner.

Process for Defining an Inbound Relationship

The process you use when defining an inbound relationship is explained in the
following table.

Stage Description

1 Create a new inbound relationship.

2 Select at least one inbound translation object.

3 Create and select at least one inbound group to define how the message is
received from this partner.

4 Create and select at least one inbound interchange to define how the message
is received from this partner.

5 Set up the corresponding outbound relationship to generate the
acknowledgements your partner requests. See About RosettaNet Outbound
Relationships for information on how to establish an outbound relationship.

Creating a RosettaNet Inbound Relationship
Before you begin

You must have already created a partner definition for this partner. See Creating a
RosettaNet Partner Definition for more information.

About this task

Use this procedure to create an inbound relationship.

Procedure
1. From the Windows Start menu, select Programs > Gentran Server > Gentran

Server.
2. Select Tools > Partner Editor.

The system displays the Partner Editor Dialog Box.
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3. Select the partner profile for which you want to create an inbound relationship
and click Inbound.
The system displays the Inbound Relationship Dialog Box.

4. Click New.
The system displays the New Inbound Relationship dialog box.

5. In the description box, type a unique relationship name and click Save.
The system creates a new inbound relationship and returns to the Inbound
Relationship dialog box.

6. From the appropriate drop-down lists on the Inbound Relationship dialog box,
select the following:
v Standard (R - RosettaNet)
v Version
v Transaction Set

Note:

v The contents of these lists are displayed from the translation objects
registered in Sterling Gentran:Server. For example, if there are no translation
objects for the RosettaNet version you are using registered with Sterling
Gentran®, you will not be available to select that version on this dialog box.

v The information required for this dialog box should be provided to you by
your trading partner when this partner defines the details of the transactions
they send you.

7. To define parameters to comply with the processing needs of your partner
(such as Sequence Checking, Last Used Control, Duplicate Documents, or
Generate Acknowledgement), click Advanced.

8. To generate an Outbound Receipt Acknowledgment in response to documents
received for this inbound relationship, click Advanced and set Generate
Acknowledgments to either Yes - With No Error Detail or Yes - With Error
Detail.

Note: If the option to Generate Acknowledgments is not turned on at the
document level, the outbound Receipt Acknowledgment will not contain all the
necessary information for a successful send.

Selecting an Inbound Translation Object
About this task

Use this procedure to select an inbound translation object.

Procedure
1. On the Inbound Relationship dialog box, click Translation.

The system displays the Inbound Translation Object Dialog Box.
2. From the drop-down lists, select the translation objects that are required for this

inbound relationship from the lists.

Note: The lists display all the translation objects that are registered in the
system that are appropriate for the type of translation object (such as Export or
Print) and the message.

3. If there are no translation objects displayed in the drop-down lists, no
translation objects of that type are registered for the correct version of the
message defined in the relationship.
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4. If you selected an Export File translation object and you want to export to a
specific file, type the universal naming convention (UNC) name of that file in
the Export File Name box.

5. To specify a mailbox and E-mail address so the output of the inbound
translation object can be delivered directly back to the Mailbox Server Manager,
select Export to Mailbox and complete the appropriate boxes.

6. Click Save to save your selections and return to the Inbound Relationship
dialog box.

Selecting an Inbound Functional Group
About this task

Use this procedure to select an inbound functional group.

Procedure
1. On the Inbound Relationship dialog box, click Groups to display a list of

existing groups.
The system displays the Inbound Group Select Dialog Box.

2. If the required group is in the Groups list, select the group and click Select.
Continue with Selecting an Inbound Interchange . Otherwise, continue with the
next step.

3. On the Inbound Group Select dialog box, click New.
The system displays the Inbound Group Entry Dialog Box.

4. In the Description box, type the group description.
5. In the Functional Group ID box, type the identification of the functional group

you are specifying.

Note: Your standards group defines which functional group ID should be used
for each type of message.

6. Click Advanced to display the full list of functional group setup options.
This extends the Inbound Group Entry dialog box.

7. For a RosettaNet partner, do the following:
v Select Acknowledge Group in the Advanced section.
v From the Ack Transaction Set ID list, select the appropriate Ack Transaction

Set ID.
v From the Acknowledge Transl.Obj. list, select the appropriate receipt

acknowledgement map.
v Click Save.

Note: When setting up an Inbound Relationship to generate outbound Receipt
Acknowledgments, acknowledgments must be turned on at the Group and
Document level.
The system stores the information and returns to the Inbound Group Select
dialog box.

8. Highlight the new group and click Select.
Selects the group and returns to the Inbound Relationship dialog box.
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Selecting an Inbound Interchange
About this task

Use this procedure to select an inbound interchange.

Procedure
1. On the Inbound Relationship dialog box, click Interchanges to display a list of

existing interchanges.
The system displays the Inbound Interchange Select Dialog Box.

2. If the required interchange is in the Interchanges list, select the interchange and
click Select. Continue with Finalizing the Inbound Relationship . Otherwise,
continue with the next step.

3. On the Inbound Interchange Select dialog box, click New.
The system displays the Inbound Interchange Entry Dialog Box.

4. In the Description box, type the interchange description.
5. In the Interchange ID box, type the identification of the interchange you are

specifying.

Note: Your standards group defines which interchange ID should be used for
each type of message.

6. Click Advanced to display the full list of interchange setup options.
This extends the Inbound Interchange Entry dialog box.

7. From the Acknowledge Transl.Obj. list, select the appropriate receipt
acknowledgement map and click Save.
The system stores the information and return to the Inbound Interchange Select
dialog box.

8. Highlight the new interchange and click Select.
Selects the interchange and returns to the Inbound Relationship dialog box.

Finalizing the Inbound Relationship
About this task

Use this procedure to finalize the inbound relationship.

Procedure
1. On the Inbound Relationship dialog box, click Save to save the inbound

relationship.
2. Click Exit to return to the Partner Editor dialog box.

Outbound Settings

Outbound Relationship Dialog Box
Outbound relationships define the parameters needed to send a message to a
trading partner. The Outbound Relationship dialog box controls other subordinate
dialogs which allow you to define everything that is necessary to establish the
relationship.

You are required to specify exactly which message the system sends. You must also
specify which translation objects are used to define the data entry formatting,
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import rules, or printing requirements. In addition, for RosettaNet you need to
define the specific PIP Initiation requirements that you agreed on with your
trading partner.

Note: The PIP Initiation requirements vary depending on which version of
RosettaNet you are using 1.1 or 2.0).

This diagram illustrates the Outbound Relationship dialog box with the Advanced
options appended.

This table describes the parts of the Outbound Relationship dialog box.

Part Function

Relationship Description Indicates the relationship description.

Standard Specifies the standard to be used in this relationship. Valid
values:

v A - TRADACOMS

v C - CII

v D - NCPDP

v E - EDIFACT

v O - ODETTE

v P - OTHER

v R - RosettaNet

v T - TDCC

v U - UCS

v V - VDA

Note: Only standards for which you have existing translation
objects are displayed. This box cannot be changed for an
existing relationship. Selection of this box is mandatory.
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Part Function

Version Specifies the standard version to be used in this relationship.
Note: Only versions of the selected standard for which you
have existing translation objects are displayed. If this box is
changed for an existing relationship, all of the information
defined below it is cleared and must be reselected. Selection of
this box is mandatory.

Transaction Set Specifies the message to be used in this relationship.
Note: Only transaction sets for the selected version (for which
you have existing translation objects) are displayed. If this box
is changed for an existing relationship, all of the information
defined below it is cleared and must be reselected. Selection of
this box is mandatory.

Release Specifies the release number to be used in this relationship.
Note: Only releases for the selected message for which you
have existing translation objects are displayed. This box is
currently only used for messages defined in the TRADACOMS
standard. Selection of this box is mandatory for all
TRADACOMS messages.

Groups Accesses the Outbound Group Select Dialog Box.

Interchanges Accesses the Outbound Interchange Select Dialog Box.

New Accesses the New Outbound Relationship dialog box, which
allows you to create a new relationship.

Delete Removes the specified outbound relationship from the system.

Translation Accesses the Outbound Translation Object Dialog Box.

Envelope Accesses one of the Outbound Envelope dialog boxes below,
depending on which version you specified.

v Outbound UNH Envelope

v Outbound MHD Envelope

v Outbound ST Envelope

v Outbound Generic Envelope

Last Used Control
Number

Specifies a value that is used to generate the next transaction set
control number or message reference. The number that is
generated will always be one more than the number in this box.
Initially, this box is set to zero.

Expect
Acknowledgement

Instructs the system to expect a functional acknowledgement to
be received from this trading partner as a result of your partner
receiving the message defined in this relationship. The default
value for this box is deselected (do not expect an
acknowledgement).

Hours Overdue Defines how many hours must elapse before an expected
functional acknowledgement is considered overdue. This box is
only valid if the Expect Acknowledgement box is selected. The
default value for this box is "48," indicating that the
acknowledgement is considered overdue in two days. If you
enter a value of zero in this box, the acknowledgement is
immediately considered overdue.
Note: This box is inactive if Expect Acknowledgement is
deselected.
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Part Function

Duplicate Documents Instructs the system to check for duplicate message names.
Note: This function checks for duplicate messages when
messages are imported manually into the Workspace. Duplicate
messages remain in the Workspace until they are deleted. If you
try to move or post a duplicate message, a warning message is
displayed.

Test Indicator Defines whether this relationship definition is in test or
production status. The default value is production.

Outbound Translation Object Dialog Box
The Outbound Translation Objects dialog box is used to specify which translation
objects are used to process the data defined by this relationship.

This table lists the outbound translation levels (hierarchically, starting with the
lowest level).

Part Function

Document Translate from import format or data entry to EDI.

Transaction Build the enveloping around a single message.

Group Build the enveloping around a set of related messages (the
messages do not have to be the same type).

Interchange Build the enveloping around groups that are destined for the
same trading partner.

Note: See the IBM Sterling Gentran:Server for Microsoft Windows Communications
User Guide for more information.

This diagram illustrates the Outbound Translation Object dialog box with the
Advanced options appended.

This table describes the parts of the Outbound Translation Object dialog box.
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Part Function

Import Displays all of the import translation objects that are in the system
for the Standard, Version, Transaction Set, and Release defined by
the relationship.

Print Displays all of the print translation objects that are in the system
for the Standard, Version, Transaction Set, and Release defined by
the relationship. The selected translation object is used to print
messages sent to this partner.

Data Entry Displays all of the screen entry translation objects that are in the
system for the Standard, Version, Transaction Set, and Release
defined by the relationship.

Application ID Defines the application identifier that indicates the destination of
the messages.

Application Alias
Value

Defines criteria for this relationship definition, which is used
instead of another relationship definition, during the application
import function.
Note: This box will only be used if you receive translation objects
that are defined to use the Application Alias Value.

TurnAround Contains other translation objects associated with the relationship,
which gives you the capability to change the system behavior at
the message translation level. This allows you to use translation
objects that are as partner-specific as required and/or perform as
many functions as required.

You select a translation object from the TurnAround list if you
have created a specific turn around translation object for this
relationship and if you want to change the way the system behaves
for this partner relationship.
Note: TurnAround translation objects may not be appropriate for
an Outbound Relationship.

Export Contains other translation objects associated with the relationship,
which gives you the capability to change the system behavior at
the message translation level. This allows you to use translation
objects that are as partner-specific as required and/or perform as
many functions as required.

You select a translation object from the Export list if you have
created a specific export translation object for this relationship and
if you want to change the way the system behaves for this partner
relationship. Export translation objects are used to export an
outbound message to a file.

Transaction Contains other translation objects associated with the relationship,
which gives you the capability to change the system behavior at
the message translation level. This allows you to use translation
objects that are as partner-specific as required and/or perform as
many functions as required.

You select a translation object from the Transaction list if you have
created a specific Transaction Build translation object for this
relationship and if you want to change the way the system behaves
for this partner relationship.
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Part Function

Acknowledge Contains other translation objects associated with the relationship,
which gives you the capability to change the system behavior at
the message translation level. This allows you to use translation
objects that are as partner-specific as required and/or perform as
many functions as required.

You select a translation object from the Acknowledge list if you
have created a specific translation object for this relationship and if
you want to change the way the system behaves for this partner
relationship. When the system generates an acknowledgement, it
writes the acknowledgement to an internal file containing the
acknowledgement details and then maps that internal file. If you
need the system to process acknowledgements differently, you
should select an additional translation object from the
Acknowledge list.

Outbound Group Select Dialog Box
The Outbound Group Select dialog box is used to select an existing functional
group definition to be associated with this relationship. You can also use it to
initiate the definition of a new functional group or to modify or delete an existing
definition. The groups that are available to you is determined by the version you
selected on the Outbound Relationship dialog box.

Functional groups are required for ANSI X12, TDCC, and UCS standards, are
optional for EDIFACT and ODETTE, and are not specified for RosettaNet and
TRADACOMS.

This diagram illustrates the Outbound Group Select dialog box.

This table describes the parts of the Outbound Group Select dialog box.

Part Function

Groups Displays all of the functional group definitions that have been
established for this trading partner.

Select Selects the indicated functional group as the one the system uses
for this relationship.

New Displays the Outbound Group Entry Dialog Box, which allows you
to create a new group.

Edit Displays the Outbound Group Entry Dialog Box, which allows you
to edit the selected group.
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Part Function

Delete Removes the selected group from the system.

Outbound Group Entry Dialog Box
The Outbound Group Entry dialog box is used to specify a new functional group
definition.

This diagram illustrates the Outbound Group Entry dialog box with the Advanced
options appended.

This table describes the parts of the Outbound Group Entry dialog box.

Part Function

Description Contains the name of the functional group description.

Standard Displays the standard the system is using for this relationship
definition.

Version Displays the version of the standard the system is using for this
relationship.

Functional Group ID Defines the identification of the functional group being specified.
These identification boxes are defined by each appropriate
standards group to group like messages. The standard defines
which functional group ID should be used with each message type.
This is a mandatory box.
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Part Function

Envelope Accesses one of the Outbound Functional Group Envelope dialog
boxes below, depending on which version you specified on the
Outbound Relationship Dialog Box.

v Outbound GS Functional Group

v Outbound UNG Functional Group

v Outbound BAT Functional Group

Note: This button is inactive for RosettaNet partner relationships.

Last Used Group
Control Number

Specifies a value that is used to generate the next interchange
control number. The number that is generated will always be one
more than the number in this box. This box will initially be set to
zero.
Note: To ensure that functional acknowledgements work correctly
you must define a unique control number for each group
relationship that exists for the same partner relationship.

Expect
Acknowledgement

Instructs the system to expect a functional acknowledgement to be
received from this trading partner as a result of your partner
receiving the group defined in this relationship. The default value
for this box is deselected (do not expect an acknowledgement).

Hours Overdue Defines how many hours must elapse before an expected
functional acknowledgement is considered overdue. This box is
only valid if the Expect Acknowledgement box is selected. The
default value for this box is "48," indicating that the
acknowledgement is considered overdue in two days. If you enter
a value of "0" (zero) in this box, the acknowledgement is
immediately considered overdue.
Note: This box is inactive if Expect Acknowledgement is
deselected.

Sequence From Group Indicates whether the transaction set control number options for
this group setup should be controlled at the group level. If this box
is deselected, then the following boxes are inactive .

Last Used Control
Number

Specifies a value that is used to generate the next transaction set
control number for the sets defined within this functional group.
The number that is generated will always be one more than the
number in this box. This box will initially be set to zero.
Note: This box is inactive if Sequence From Group is deselected.
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Part Function

Format Specifies the format of the transaction set control number that is
generated.

v Normal - The number is generated by incrementing the last used
control number. The length of the number is defined by the
standard.

v 6/3 - The number is a composite of two numbers. The first six
digits are the last six digits of the functional group control
number. The last three digits are a counter beginning at "1"
within the functional group. Use this format only as instructed
by your trading partner.

v 5/4 - The number is a composite of two numbers. The first five
digits are the last five digits of the functional group control
number. The last four digits are a counter beginning at "1"
within the functional group. This is the normal TDCC
numbering convention. It is used by the Motor, Rail, and Ocean
transportation industries.

v 5/3 - The number is a composite of two numbers. The first five
digits are the last five digits of the functional group control
number. The last three digits are a counter beginning at "1"
within the functional group. This is the normal UCS convention,
which is used by the Grocery and Warehousing industries.

Note: This box is inactive if Sequence From Group is deselected.

Group Transl. Obj. Contains a partner-specific Group Build Map translation object if
this trading partner group deviates from the normal system
behavior. You will select a translation object from this list if you
want the system to perform partner-specific grouping.
Important: We strongly recommend that you do not change the
translation objects in the Group Transl. Obj. and Acknowledge
Transl. Obj. lists, unless you have a specific reason for doing so.

Acknowledge Transl.
Obj.

Contains an acknowledgement build map if one exists on the
system.

You select a translation object from the Acknowledge Transl. Obj.
list if you have created a specific translation object for this
relationship and if you want to change the way the system behaves
for this partner group. When the system reconciles an
acknowledgement, it maps the acknowledgement to an internal file
and then processes it. If you need the system to process
acknowledgements differently, you should select an additional
translation object from the Acknowledge list.
Important: We strongly recommend that you do not change the
translation objects in the Group Transl. Obj. and Acknowledge
Transl. Obj. lists, unless you have a specific reason for doing so.

Outbound Interchange Select Dialog Box
The Outbound Interchange Select dialog box is used to select an existing
interchange definition to be associated with this relationship. It can also be used to
initiate the definition of a new interchange, or to modify or delete an existing
definition. The interchanges available to you are determined by the version you
selected on the Outbound Relationship dialog box. Interchanges are required for
RosettaNet, EDIFACT, ODETTE, TRADACOMS, and UCS, and are optional for
ANSI X12 and TDCC.

This diagram illustrates the Outbound Interchange Select dialog box.
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This table describes the parts of the Outbound Interchange Select dialog box.

Part Function

Interchanges Displays all of the interchange definitions that have been
established for this trading partner.

Select Selects the indicated interchange to be used with this relationship.
Note: Select <none> if the standard you are using does not require
interchanges and you do not want to use one.

New Displays the Outbound Interchange Entry Dialog Box, which
allows you to create a new interchange.

Edit Displays the Outbound Interchange Entry Dialog Box, which
allows you to edit the selected interchange.

Delete Removes the selected interchange from the system.

Outbound Interchange Entry Dialog Box
The Outbound Interchange Entry dialog box is used to specify a new interchange
definition.

This diagram illustrates the Outbound Interchange Entry dialog box with the
Advanced options appended.
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See the IBM Sterling Gentran:Server for Microsoft Windows Communications User Guide
for more information.

This table describes the parts of the Outbound Interchange Entry dialog box.

Part Function

Description Contains the name of the interchange description.

Standard Displays the standard the system is using for this relationship
definition.

Version Displays the version of the standard the system is using for this
relationship.

Interchange ID Defines the type of interchange you specified. The standard defines
which interchange ID should be used with each standard. This is a
mandatory box.

42 IBM Sterling Gentran:Server for Windows: RosettaNet User Guide



Part Function

Envelope Accesses one of the Outbound Interchange Envelope dialog boxes
below, depending on which version you specified on the
Outbound Relationship Dialog Box.

v Outbound ISA Envelope

v Outbound ICS Envelope

v Outbound BG Envelope

v Outbound UNB Envelope

v Outbound UNA Envelope

v Outbound STX Envelope

v Outbound VDA Envelope

v Outbound NCPDP Envelope

v Outbound Envelope PIP Initiation (RosettaNet only)

Refer to Outbound Envelope PIP Initiation Dialog Box for more
information on that dialog box or refer to the Partner Editor online
help for specific information about the envelope dialog boxes for
non-RosettaNet standards.
Note: The PIP Initiation requirements vary depending on which
version of RosettaNet you are using (1.1 or 2.0).

Use the default
Mailbox and E-mail
Address

Indicates that the system will use the default Mailbox and E-mail
address specified on the Partner Definition (New/Edit) Dialog Box.

Mailbox Specifies a mailbox to use to identify this partner for RosettaNet
relationships.

E-mail Address Specifies an e-mail address to use to identify this partner for
RosettaNet relationships.

New Mailbox Displays the Create New Mailbox wizard, which allows you to
create a new mailbox.

Edit Mailbox Displays the Mailbox Properties dialog box, which allows you to
edit the mailbox.

Content Type Defines the content type of the interchange.

Set Max Number of
Documents per
Interchange

Instructs the system to only allow the specified maximum number
of messages per interchange for this relationship.

Max Number of
Documents per
Interchange

Specifies the maximum number of messages allowed per
interchange for this relationship.
Note: This value is disabled for RosettaNet because only one PIP
is allowed per interchange.

Last Used Control
Number

Specifies a value that is used to generate the next interchange
control number. The number that is generated is always one more
than the number in this box. Initially, this box is set to zero.

Expect
Acknowledgement

Instructs the system to expect a functional acknowledgement to be
received from this trading partner as a result of your partner
receiving the interchange set defined in this relationship. The
default value for this box is deselected (do not expect an
acknowledgement).
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Part Function

Hours Overdue Defines how many hours must elapse before an expected
functional acknowledgement is considered overdue. This box is
only valid if the Expect Acknowledgement box is selected. The
default value for this box is "48," indicating that the
acknowledgement is considered overdue in two days. If you enter
a value of zero in this box, the acknowledgement is immediately
considered overdue.
Note: This box is inactive if Expect Acknowledgement is
deselected.

Interchange Transl.
Obj.

Allows you to select a partner-specific Interchange Build Map
translation object if this trading partner interchange deviates from
the normal system behavior. You will select a translation object
from this list if you want the system to perform partner-specific
interchanging.
Important: We strongly recommend that you do not change the
translation objects in this list, unless you have a specific reason for
doing so.
Note:

v If you are sending streamed interchanges, you should verify that
the "RosettaNet1_1 int bld Streaming" build map is selected.

v If you are sending interchanges that use carriage returns/line
feeds, you should verify that the "RosettaNet 1_1 int bld New
Line" build map is selected.

Acknowledge Transl.
Obj.

Contains an acknowledgement build map if one exists on the
system.

You select a translation object from the Acknowledge Transl. Obj.
list if you have created a specific translation object for this
relationship and if you want to change the way the system behaves
for this partner interchange. When the system reconciles an
acknowledgement, it maps the acknowledgement to an internal file
and then processes it. If you need the system to process
acknowledgements differently, you should select an additional
translation object from the Acknowledge list.
Important: We strongly recommend that you do not change the
translation objects in this list, unless you have a specific reason for
doing so.

Outbound Envelope PIP Initiation Dialog Box
The Outbound Envelope PIP Initiation dialog box is used to specify enveloping
options for a PIP.

Note: The PIP Initiation requirements vary depending on which version of
RosettaNet you are using.

RosettaNet version 1.1

This diagram illustrates the Outbound Envelope PIP Initiation dialog box (version
1.1).
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This table describes the parts of the Outbound Envelope PIP Initiation dialog box
for RosettaNet version 1.1.

Part Function

Global Administering
Authority Code

Specifies the controlling agency (RosettaNet). The applicable
RosettaNet codes are listed in the Service Header Guideline. This
value is mandatory.

Version ID Specifies the RNIF version number. This value is mandatory.

Global Usage Code Indicates whether the PIP is test or production. The applicable
RosettaNet codes are listed in the Service Header Guideline. This
value is mandatory.

Action Identity

Transaction Version ID Specifies the version of message guideline that is used. This value
is mandatory.

Process Identity
Version ID

Specifies the PIP version. This value is mandatory.

Global Indicator Code Specifies the RosettaNet-defined process. The applicable RosettaNet
codes are listed in the Service Header Guideline. This value is
mandatory.

Global Doc Function
Code

Indicates whether the message is a "Request" or "Response." The
applicable RosettaNet codes are listed in the Service Header
Guideline. This value is mandatory.

Sender: DUNS+4 Specifies the DUNS number of the partner sending the PIP. This
value is mandatory.

Receiver: DUNS+4 Specifies the DUNS number of the partner receiving the PIP. This
value is mandatory.

Sender: Global Partner
Classification Code

Specifies the code used to describe the function of the partner
sending the PIP. This value is mandatory.
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Part Function

Receiver: Global
Partner Classification
Code

Specifies the code used to describe the function of the partner
receiving the PIP. The applicable RosettaNet codes are listed in the
Service Header Guideline. This value is mandatory.

Receiver: Global
Business Service Code

Specifies the service that the receiving partner is performing. The
applicable RosettaNet codes are listed in the Service Header
Guideline. This value is mandatory.

Time Allowance to
Ack Acceptance

Specifies the amount of time allowed to acknowledge receipt of
acceptance, other than the designated default amount of time.

Format: Type time in minutes.

Time Allowance to
Ack Receipt

Specifies the amount of time allowed to acknowledge receipt other
than the designated default amount of time.

Format: Type time in minutes.

Time Allowance to
Perform

Specifies the time allotted to perform other than the designated
default time.

Format: Type time in minutes.

Sender: Global Partner
Role Classification
Code

Specifies a code used to describe the role of the partner sending
the PIP. The applicable RosettaNet codes are listed in the Service
Header Guideline. This value is mandatory.

Receiver: Global
Partner Role
Classification Code

Specifies a code used to describe the role of the partner receiving
the PIP. The applicable RosettaNet codes are listed in the Service
Header Guideline. This value is mandatory.

Global Transaction
Code

Describes the message. The applicable RosettaNet codes are listed
in the Service Header Guideline. This value is mandatory.

Global Process Code Specifies the RosettaNet-defined code that describes the message
type. The applicable RosettaNet codes are listed in the Service
Header Guideline. This value is mandatory.

PIP Initiating Partner:
Global Business
Identifier

Specifies the DUNS number of the partner sending the PIP. This
value is mandatory.

Sender: Global
Business Service Code

Specifies a code used to describe the service the sending partner is
performing. The applicable RosettaNet codes are listed in the
Service Header Guideline. This value is mandatory.

RosettaNet version 2.0

This diagram illustrates the Outbound Envelope PIP Initiation dialog box (version
2.0).
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This table describes the parts of the Outbound Envelope PIP Initiation dialog box
for RosettaNet version 2.0.

Part Function

Global Administering
Authority Code

Specifies the controlling agency (RosettaNet). The applicable
RosettaNet codes are listed in the Service Header Guideline. This
value is mandatory.

PIP Version Specifies the version number of the PIP. This value is mandatory.

Version ID Specifies the RNIF version number. This value is mandatory.

Global Usage Code Indicates whether the PIP is test or production. The applicable
RosettaNet codes are listed in the Service Header Guideline. This
value is mandatory.

Sender: DUNS+4 Specifies the DUNS number of the partner sending the PIP. This
value is mandatory.

Receiver: DUNS+4 Specifies the DUNS number of the partner receiving the PIP. This
value is mandatory.

To Global Partner
Role Classification
Code

Specifies a code used to describe the role of the partner receiving
the PIP. The applicable RosettaNet codes are listed in the Service
Header Guideline. This value is mandatory.

From Global Partner
Role Classification
Code

Specifies a code used to describe the role of the partner sending
the PIP. The applicable RosettaNet codes are listed in the Service
Header Guideline. This value is mandatory.

Business Activity
Identifier

Specifies an identifier for special validation and processing rules
corresponding to the currently executing PIP and activity. This
value is mandatory.

From Global Business
Service Code

Specifies a code used to describe the service the sending partner is
performing. The applicable RosettaNet codes are listed in the
Service Header Guideline. This value is mandatory.

Global Process
Indicator Code

Specifies the RosettaNet-defined process. The applicable RosettaNet
codes are listed in the Service Header Guideline. This value is
mandatory.

Secure Transport
Required

Indicates to the trading partner that all responses to this document
must be sent using the SSL protocol.
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Part Function

To Global Business
Service Code

Specifies the service that the receiving partner is performing. The
applicable RosettaNet codes are listed in the Service Header
Guideline. This value is mandatory.

Receiver Identification
Domain

Specifies the DUNS number. This value is mandatory.

Receiver Location
Identifier

Specifies a logical business location associated with this trading
partner. This value is mandatory.

Sender Identification
Domain

Specifies the DUNS number. This value is mandatory.

Sender Location
Identifier

Specifies your logical business location associated with this trading
partner. This value is mandatory.

About RosettaNet Outbound Relationships
To correctly send information to a trading partner, you need to define an outbound
relationship. Outbound relationships define the parameters needed to send a data
file to a trading partner. Each outbound relationship defines the format of a single
business message, and how that business message is formatted and sent to the
specified trading partner.

You must set up several parameters that are used to create an outbound
relationship. These parameters tell the system the following information:
v How to create the required message.
v The criteria that the system uses to validate the information entered.
v How to create the interchange envelope in preparation for sending.

Translation Objects

Each outbound relationship must have one or more associated outbound
translation objects. These translation objects determine how the sent data is
formatted. You need to specify which translation objects are used to define the
rules for screen entry or file import. At a minimum, one translation object must be
available.

Note: If this relationship requires a new translation object, you must register that
translation object with the system before creating the outbound relationship. See
How to Register a New Translation Object in the IBM Sterling Gentran:Server for
Microsoft Windows User Guide for instructions on how to register translation objects.

Outbound Groups and Interchanges

For RosettaNet, you must define or select an outbound interchange and outbound
functional group before the system allows you to complete the setup of an
outbound relationship. The outbound functional group defines the format of the
functional group and the parameters that should be used to verify it. The
outbound interchange defines the format of the interchange and the parameters
that should be used to verify it.

If you do not want to use an optional functional group or interchange you must
still select <none> from the appropriate dialog box to alert the system that you are
not using a group.
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Before you Begin

Before setting up an outbound relationship, you must know the following
information to plan the implementation of this partner:
v The EDI standard that you expect from this trading partner (RosettaNet).
v The standard version that you expect from this trading partner (1.1 or 2.0 for

RosettaNet).
v The code for the message you expect from this trading partner (such as Purchase

Order Request).
v The type of functional group and interchange the message is wrapped in when

it is sent to this partner.

Process for Defining an Outbound Relationship

The process you use when defining an outbound relationship is explained in the
following table.

Stage Description

1 Create a new outbound relationship.

2 Select at least one outbound translation object.

3 Create and select at least one outbound group to define how the message is
received from this partner.

4 Create and select at least one outbound interchange to define how the
message is received from this partner.

5 If you are using the RosettaNet standard, complete the Outbound Envelope
PIP Initiation Dialog Box at the interchange level.

6 If you have not done so already, set up the corresponding inbound
relationship to receive the acknowledgements you expect from your partner.
See About RosettaNet Inbound Relationships for information on how to
establish an inbound relationship.

Creating a RosettaNet Outbound Relationship
About this task

Use this procedure to create an outbound relationship.

Procedure
1. From the Windows Start menu, select Programs > Gentran Server > Gentran

Server.
2. Select Tools > Partner Editor.

The system displays the Partner Editor Dialog Box.
3. Select the partner profile for which you want to create an outbound

relationship and click Outbound.

Note: You must have already created a partner definition for this partner.
The system displays the Outbound Relationship Dialog Box.

4. Click New.
The system displays the New Outbound Relationship dialog box.

5. In the description box, type a unique relationship name and click Save.
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The system creates a new outbound relationship and returns to the Outbound
Relationship dialog box.

6. From the appropriate drop-down lists on the Outbound Relationship dialog
box, select the following:
v Standard (R - RosettaNet)
v Version
v Transaction Set

Note:

v The contents of these lists are displayed from the translation objects
registered in Sterling Gentran:Server. For example, if there are no translation
objects for the RosettaNet version you are using registered with Sterling
Gentran, you will not be available to select that version on this dialog box.

v The information required for this dialog box should be provided to you by
your trading partner when this partner defines the details of the transactions
they send you.

7. If you need to define parameters to comply with the processing needs of your
partner (such as Last Used Control Number, Expect Acknowledgement, Hours
Overdue, Duplicate Documents, or Test Indicator), click Advanced.

Selecting an Outbound Translation Object
About this task

Use this procedure to create an outbound relationship.

Procedure
1. On the Outbound Relationship dialog box, click Translation.

The system displays the Outbound Translation Object Dialog Box.
2. From the drop-down lists, select the translation objects that are required for this

outbound relationship from the lists.

Note: The lists display all the translation objects that are registered in the
system that are appropriate for the type of translation object (such as Import or
Print) and the message.

If there are no translation objects displayed in the drop-down lists, no
translation objects of that type are registered for the correct version of the
message defined in the relationship.

3. If you selected an Import translation object, you may need to define the
following:
v In the Application ID box, type the application identifier that indicates the

destination for the messages.
v In the Application Alias Value box, type criteria that the system will use to

distinguish this relationship from others during the application import
function.

4. Click Save to save your selections and return to the Outbound Relationship
dialog box.
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Selecting an Outbound Functional Group
About this task

Use this procedure to create an outbound relationship.

Procedure
1. On the Outbound Relationship dialog box, click Groups to display a list of

existing groups.
The system displays the Outbound Group Select Dialog Box.

2. If the required group is in the Groups list, select the group and click Select.
Continue with Selecting an Outbound Interchange. Otherwise, continue with
the next step.

3. On the Outbound Group Select dialog box, click New.
The system displays the Outbound Group Entry Dialog Box.

4. In the Description box, type the group description.
5. In the Functional Group ID box, type the identification of the functional group

you are specifying.

Note: Your standards group defines which functional group ID should be used
for each type of message.

6. Click Advanced to display the full list of functional group setup options.
This extends the Outbound Group Entry dialog box.

7. From the Group Transl. Obj. list, select the appropriate build translation object
and click Save.
The system stores the information and return to the Outbound Group Entry
dialog box.

8. Click Save to store the information.
9. Highlight the new group and click Select.

Selects the group and returns to the Outbound Relationship dialog box.

Selecting an Outbound Interchange
About this task

Use this procedure to create an outbound relationship.

Procedure
1. On the Outbound Relationship dialog box, click Interchanges to display a list

of existing interchanges.
The system displays the Outbound Interchange Select Dialog Box.

2. If the required interchange is in the Interchanges list, select the interchange
and click Select. Continue Finalizing the Outbound Relationship. Otherwise,
continue with the next step.

3. On the Outbound Interchange Select dialog box, click New.
The system displays the Outbound Interchange Entry Dialog Box.

4. In the Description box, type the interchange description.
5. In the Interchange ID box, type the identification of the interchange you are

specifying.

Note: Your standards group defines which interchange ID should be used for
each type of message.
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6. Click Advanced to display the full list of interchange setup options.
This extends the Outbound Interchange Entry dialog box.

7. If you are not using the default Mailbox and E-mail Address, select the
appropriate mailbox from the Mailbox list or click New Mailbox.

Note: See the IBM Sterling Gentran:Server for Microsoft Windows Communications
User Guide for more information on creating mailboxes.

8. From the Interchange Transl. Obj. list, select the appropriate build translation
object and click Save.
The system stores the information and return to the Outbound Interchange
Entry dialog box.

9. Click Envelope to set up the parameters for the generation of the interchange
segment.
The system displays a message box asking if you want to initiate a PIP.

10. Click Yes.
The system displays the Outbound Envelope PIP Initiation Dialog Box.

11. After you set up the required parameters in the enveloping dialog box, click
Save to store the information and return to the Outbound Interchange Entry
dialog box.

12. Click Save to store the information.
13. Highlight the new interchange and click Select.

Selects the interchange and returns to the Outbound Relationship dialog box.

Finalizing the Outbound Relationship
About this task

Use this procedure to create an outbound relationship.

Procedure
1. On the Outbound Relationship dialog box, click Save to save the outbound

relationship.
2. Click Exit to return to the Partner Editor dialog box.

52 IBM Sterling Gentran:Server for Windows: RosettaNet User Guide



Chapter 3. Configuring Maps for Use with RosettaNet

About Sample Maps
Before the system can receive inbound RosettaNet documents, you must place the
corresponding DTD for that type of document in the GENSRVNT\Bin directory.

Sterling Gentran:Server for RosettaNet installs sample maps into the
GENSRVNT\RosettaNet\Tutorials\Maps\Source folder. You can access these maps
through the Application Integration subsystem at any time. See the IBM Sterling
Gentran:Server for Microsoft Windows Application Integration User Guide for more
information on how to use the Application Integration subsystem.

IBM Sterling Gentran:Server for Microsoft Windows for RosettaNet installs the
DTDs listed in this table into the GENSRVNT\RosettaNet\Complete DTD Examples
folder.

DTD File Function

CompleteInboundAction RNIF1_1.DTD Used by you to build the INPUT side of your inbound
RosettaNet RNIF 1.1 map.

CompleteInboundAction RNIFV02_00.DTD Used by you to build the INPUT side of your inbound
RosettaNet RNIF 2.0 map.

CompleteOutboundAction RNIF1_1.DTD Used by you to build the OUTPUT side of your outbound
RosettaNet RNIF 1.1 map.

CompleteOutboundAction RNIFV02_00.DTD Used by you to build the OUTPUT side of your outbound
RosettaNet RNIF 2.0 map.

CompleteOutboundAction
WithAttachmentsRNIFV02_00.DTD

Used by you to build the OUTPUT side of your outbound
RosettaNet RNIF 2.0 map for an outbound action with
attachments.
Note: Use this DTD if you are using attachments.

DeliveryHeader_MS_V02_00.DTD Used by the CompleteOutboundActionRNIFV02_00.DTD to create
the delivery header part of the map.

Preamble_MS_V02_00.DTD Used by the CompleteOutboundActionRNIFV02_00.DTD to create
the preamble part of the map.

PreamblePartMessageGuideline.DTD Used by the CompleteInboundActionRNIF1_1.DTD/
CompleteInboundActionRNIFV02_00.DTD and
CompleteOutboundActionRNIF1_1.DTD/
CompleteOutboundActionRNIFV02_00.DTD to create the preamble
part of the map.

ServiceHeader_MS_V02_00.DTD Used by the CompleteOutbound ActionRNIFV02_00.DTD to create
the service header part of the map.

ServiceHeader_MS_V02_00 AttachmentOnly.DTD Used by the CompleteOutbound ActionWithAttachments
RNIFV02_00.DTD to create the service header part of the map.

ServiceHeaderPartMessageGuideline.DTD Used by the CompleteInboundActionRNIF1_1.DTD/
CompleteInboundActionRNIFV02_00.DTD and
CompleteOutboundActionRNIF1_1.DTD/
CompleteOutboundActionRNIFV02_00.DTD to create the service
header part of the INPUT and OUTPUT sides of the map.
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RosettaNet Map Process Flow

Notes:

v The DTDs are located in GENSRVNT\RosettaNet\Complete DTD examples.
v See the IBM Sterling Gentran:Server for Microsoft Windows Application Integration

User Guide for more information on maps.

This table describes the tasks that you perform to configure each RosettaNet map.

Stage Description

1 Download the DTD for the appropriate Action from the RosettaNet website.
Notes:

v Locate the DTD in the same folder as the DTDs provided with Sterling Gentran:Server for
RosettaNet.

v Before the system can receive inbound RosettaNet documents, you must place the corresponding
DTD for that type of document in GENSRVNT\Bin.

2 Using a text editor, open the DTD depending on what version your map is:

v inbound and RNIF version 1.1 - CompleteInboundActionRNIF1_1.DTD

v inbound and RNIF version 2.0 - CompleteInboundActionRNIFV02_00.DTD

v outbound and RNIF version 1.1 - CompleteOutboundActionRNIF1_1.DTD

v outbound and RNIF version 2.0 - CompleteOutboundActionRNIFV02_00.DTD

v outbound with attachments and version 2.0 -
CompleteOutboundActionWithAttachmentsRNIFV02_00.DTD

3 For the defineAction entity, enter the name of the DTD that you downloaded.

4 Replace the word "Action" with the root tag of the DTD in the following locations:

v <!ENTITY % defineAction SYSTEM "Action To be Mapped">

v %defineAction;

5 Depending on your map version, replace the word "Action" with the root tag of the DTD in the
following locations:

v Inbound RNIF version 1.1 - <!ELEMENT RosettaNetMerge1.1 ( Pxml, PDOCTYPE, Preamble, Pxml,
PDOCTYPE, ServiceHeader, Pxml, PDOCTYPE, Action ) >

v Inbound RNIF version 2.0 - <!ELEMENT RosettaNetMergeV02_00 ( Pxml, PDOCTYPE, Preamble, Pxml,
PDOCTYPE, ServiceHeader, Pxml, PDOCTYPE, Action ) >

v Outbound RNIF version 1.1 - <!ELEMENT RosettaNetMerge1.1 ( ServiceHeader, Action ) >

v Outbound RNIF version 2.0 - <!ELEMENT RosettaNetMergeV02_00 ( ServiceHeader, Action ) >

v Outbound RNIF version 2.0 with attachments- <!ELEMENT RosettaNetMergeWithAttachmentsV02_00 (
ServiceHeader, Action ) >

6 Define the XML standards that you and your trading partners will use. Make sure these standards are
installed on your hard drive and are available to Sterling Gentran:Server.

7 Using Application Integration, create the import or export map and select the DTD that you modified.
Notes:

v For inbound you will create an export map.

v For outbound you will create an import map.

See Creating an Inbound Map for Use with RosettaNet and Creating an Outbound Map for Use with
RosettaNet for more information on selecting the DTD when you create the map.
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Stage Description

8 For all outbound maps, you need to populate the DTD with the appropriate values. To do so, you need
to ensure that you populate the attributes in the following table on the output side of the map with
data.

For this value Map it like this

ServiceContentDTD Use an extended or standard rule so the value of this field is equal
to the RosettaNet DTD for that action.

For example: #ServiceContentDTD =
"3A4PurchaseOrder�AcceptanceMessageGuideline_v1_1.dtd";
Note: This field must be populated only if you are using
attachments.

ServiceContentDoctype Use an extended or standard rule so the value of this field is equal
to the RosettaNet DTD for that action.

For example: #ServiceContentDoctype =
"PIP3A4PurchaseOrderAcceptance";

PartnerName Use a Select standard rule to map the partner name into this field.

InResponseDocumentName No rule is required. This field is equivalent to the proprietary
document identifier for the document to which it is responding.

DocumentName Link to the proprietary document identifier for this document for
the action being mapped.

GlobalBusinessActionCode Use an extended or standard rule so the value of this field is equal
to the value contained in the PIP profile.

For example: #GlobalBusinessActionCode = "Purchase Order
Acceptance Action";

9 Configure the Translation Object Details for each map. See Defining RosettaNet Translation Object
Details for more information.

10 Save and compile the translation object.

11 Register the translation object with Sterling Gentran:Server.

12 Select the translation object for the appropriate trading partner relationship.

Creating an Inbound Map for Use with RosettaNet
Use the Application Integration New XML Wizard to create your format from a
selected predefined document source type (such as the DTD you modified).

About this task

Use this procedure to create an inbound map for use with RosettaNet.

Procedure
1. From the Windows Start menu, select Programs > Gentran Server > Gentran

Server Application Integration.
The system displays the Sterling Gentran:Server Application Integration
window.

2. Select File > New.
The system displays the New Map Wizard.

3. Enter the following information and click Next:
a. Select Export as the type of map.
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b. Enter the unique name of the map. The system adds the .MAP extension.
c. Enter your name if it differs from the user name prompted by the system.

Note: You need to complete the format of the Input side of the map. This is
the format of the data that is translated by the Sterling Gentran:Server system.

4. Select XML from the Create a new data format using this syntax list.
5. Click Customize.

Note: The New XML Wizard enables you to create your format from a
selected predefined document source type (such as the DTD you modified).

6. Do the following:
a. Type the name of your DTD file or a URL pointing to the DTD and click

Next.
b. Select the Root Element, set the maximum length of data elements, and

click Next.
c. Click Finish.

Notes:

v The DTD does not explicitly define the root element, so you can choose
from all the elements defined in the DTD. By default, the wizard selects the
first element encountered in the DTD.

v You can specify the maximum length of data elements because this is not
defined in the DTD.

If the system needed to make changes to the DTD to make it compliant with
Sterling Gentran:Server, the system informs you of the changes. Click OK.

7. Select the appropriate file format from the Create a new data format using this
syntax list. Click Next

8. Do the following:
a. From the Document Source Type list, select DTD and click Next.
b. Type the name of your DTD file or a URL pointing to the DTD and click

Next.
c. Select the doctype, set the maximum length of data elements, and click

Next.
d. Click Finish.

Notes:

v The DTD does not explicitly define the root element, so you can choose
from all the elements defined in the DTD. By default, the wizard selects the
first element encountered in the DTD.

v You can specify the maximum length of data elements because this is not
defined in the DTD.

v If the system needed to make changes to the DTD to make it compliant
with Sterling Gentran:Server, the system informs you of the changes. Click
OK.

9. Click Finish to load the standards information you selected and create the
new map (this may take a few seconds).
The system displays the new map in the Application Integration Window.

10. Create the structure of your application file on the output side of the map and
perform the necessary mapping functions to move your data.
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Creating an Outbound Map for Use with RosettaNet
Use the Application Integration New XML Wizard to create your format from a
selected predefined document source type (such as the DTD you modified).

About this task

Use this procedure to create an outbound map for use with RosettaNet.

Procedure
1. From the Windows Start menu, select Programs > Gentran Server > Gentran

Server Application Integration.
The system displays the Sterling Gentran:Server Application Integration
window.

2. Select File > New.
The system displays the New Map Wizard.

3. Enter the following information and click Next:
v Select Import as the type of map.
v Enter the unique name of the map. The system adds the .MAP extension.
v Enter your name if it differs from the user name prompted by the system.

Note: You need to complete the format of the Input side of the map. This is the
format of the data that is translated by the Sterling Gentran:Server system.

4. Select XML from the Create a new data format using this syntax list. Click
Next.

5. Click Customize.

Note: The New XML Wizard enables you to create your format from a selected
predefined document source type (such as the DTD you modified).

6. Do the following:
a. From the Document Source Type list, select DTD and click Next.
b. Type the name of your DTD file or a URL pointing to the DTD and click

Next.
c. Select the doctype, set the maximum length of data elements, and click

Next.
d. Click Finish.

Notes:

v The DTD does not explicitly define the root element, so you can choose from
all the elements defined in the DTD. By default, the wizard selects the first
element encountered in the DTD.

v You can specify the maximum length of data elements because this is not
defined in the DTD.

v If the system needed to make changes to the DTD to make it compliant with
Sterling Gentran:Server, the system informs you of the changes. Click OK.

7. Click Finish to load the standards information you selected and create the new
map (this may take a few seconds).
The system displays the new map in the Application Integration Window.

8. Create the structure of your application file on the input side of the map and
perform the necessary mapping functions to move your data.
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Defining RosettaNet Translation Object Details
You need to define the RosettaNet-specific details for your map. The Application
Integration Translation Object Details dialog box enables you to edit the details of
the translation object, including the description and version information.

About this task

Use this procedure to specify translation object details.

Procedure
1. With your map open in Application Integration, select Edit > Details.

The system displays the Translation Object Details dialog box.
2. In the first Agency box for the RosettaNet side of the map (Input or Output,

depending on the direction of the map), type R.

Note:

v For an Outbound map, the RosettaNet side is output.
v For an Inbound map, the RosettaNet side is input.

3. In the second Agency box for the RosettaNet side of the map (Input or Output,
depending on the direction of the map), type RosettaNet.

4. In the Version box for the RosettaNet side of the map (Input or Output,
depending on the direction of the map), type the RNIF version from the
preamble.

5. In the Transaction box for the RosettaNet side of the map (Input or Output,
depending on the direction of the map), type the descriptive name of the
message.

6. In the F Group box for the RosettaNet side of the map (Input or Output,
depending on the direction of the map), type the PIP to which the message
belongs.

7. To change the map version, type the appropriate version numbers in the Major
and Minor boxes.

8. Click OK.
The system saves your changes and exits the Translation Object Details dialog
box.
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Chapter 4. Using the Security Profile Manager and
Communication Tasks

About the Security Profile Manager
The Security Profile Manager enables you to administer the certificates required to
encrypt, decrypt, sign, and verify messages as they flow in and out of Sterling
Gentran:Server.

Note: The Security Profile Manager only resides on the Sterling Gentran:Server
Mailbox Server, and is responsible for managing the digital certificate on that
machine. The nature of certificate management makes it impossible to remotely
administer these functions.

Sterling Gentran:Server for RosettaNet allows you to use any mailbox transport
system, including the HTTP and Internet E-Mail communications gateways. The
only communications component contained within the Sterling Gentran:Server
product is the RosettaNet delivery agent.

Digital certificates

Sterling Gentran:Server for RosettaNet enables you to use self-signed digital
certificates, which allow you to verify that the PIPs you receive are from the
partner you expected, and to allow your partners to verify that the PIPs you send
to them are really from your company.

Self-signed digital certificates are agreed upon by you and your partner. These
certificates do not require any additional expenditure but they are contingent upon
a trusting relationship that is maintained between you and your partner.

Note: Any digital certificate that you use must also exist in duplicate on your
trading partner’s system.

The trading partner’s public key, which is imported via the Security Profile
Manager, is used to verify incoming digital signatures. The digital signature
contains sufficient information to look up this public key. Any verification failures
are noted in the Sterling Gentran:Server Audit Log and are considered security
violations (that is, any digitally signed message that cannot be verified will be
discarded and not processed).

Attachments

Inbound attachments: If you use RNIF 2.0 and attachments are found and verified,
Sterling Gentran:Server for RosettaNet gives you the ability to transport the
attachments to a mailbox message.

Outbound attachments: If you use RNIF 2.0 and you link your application
information to the attachment portion of the manifest section of the RNIF 2.0
service header, Sterling Gentran:Server for RosettaNet allows you to send
attachments to your trading partners.

Note: If you are using attachments, you must use the
CompleteOutboundAttachmentRNIFV02_00.DTD that we provide.
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v Use the above DTD to create your map.
v Populate or link all the map components in the Manifest portion of the Service

Header.
– Description is optional.
– GlobalMIMETypeQualifierCode is mandatory.
– UniversalResourceIdentifier is mandatory and it must contain a valid path

to which the delivery agent has access.
– NumberofAttachments is mandatory and must contain the appropriate value.

Delivery Agent
A delivery agent is a Dynamic Link Library (DLL) that performs processing on
messages that are sent and received by Mailbox Server.

The RosettaNet Agent delivery agent normalizes your data (without regard to the
version of RNIF used) into one database table (PIPTrack_tb).

You need to create a RosettaNet mailbox for each outbound trading partner and
configure it (via a delivery rule) to route messages via the RosettaNet delivery
agent. Delivery Rules allow you to run executable programs on the message when
specific criteria for that message is met.

Encryption and decryption

For RNIF 2.0, the RosettaNet Agent provides you with the ability to decrypt
incoming messages using a private key, and to encrypt (if required) when sending
documents, based on the public key associated with the receiving partner
contained in the delivery header.

The RNIF 2.0 message sender encrypts either the payload or the payload container
of the outgoing RosettaNet message, which uses either the RC2 algorithm or the
TripleDES algorithm. These outbound encryption settings are configured via the
PIP Profiler. See Creating a PIP Profile for more information.

An incoming RNIF 2.0 message that contains encrypted content is decrypted using
the private key of the message receiver. Decryption failure results in an entry to
the Sterling Gentran:Server Audit Log and a security violation (that is, the
incoming message is discarded and not processed).

Inbound XML parsing

The RosettaNet Agent runs a validating XML parse against all inbound RosettaNet
XML message parts to ensure that they conform to the appropriate DTDs. Any
validation errors will be reported in the Sterling Gentran:Server Audit Log.

The DTD for the document that is received must be located in GENSRVNT\Bin.

RosettaNet Communications Processes
If you are running in a double-firewall (DMZ) environment, install and configure
the HTTP Message Forwarder. Set the default destination URL to the HTTP
Gateway URL configured on the Sterling Gentran:Server system where Sterling
Gentran:Server for RosettaNet is installed.
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RNIF 1.1 inbound

This table describes the Sterling Gentran:Server for RosettaNet inbound data flow
for RNIF 1.1.

Note: See the IBM Sterling Gentran:Server for Microsoft Windows HTTP Message
Forwarder Configuration Guide for instructions on configuring the HTTP Message
Forwarder.

Stage Description

1 Create a new HTTP Gateway mailbox configured to receive messages.
Notes:

v Set the MIME tag/value pairs to the following:

– Tag: CONTENT-TYPE:

– Value: APPLICATION/X-ROSETTANET-AGENT; VERSION=1.0

v Set the Content Type and SubContent to Application/RosettaNet.

v Set Sterling Gentran:Server Application as the recipient.

2 Add the RosettaNet delivery agent configured for inbound to this mailbox.
See Creating RosettaNet Mailboxes for Inbound RNIF 1.1 and 2.0 for more
information.

RNIF 2.0 inbound

This table describes the Sterling Gentran:Server for RosettaNet inbound data flow
for RNIF 2.0.

Note: See the IBM Sterling Gentran:Server for Microsoft Windows HTTP Message
Forwarder Configuration Guide for instructions on configuring the HTTP Message
Forwarder.

Stage Description

1 Create a new HTTP Gateway mailbox configured to receive messages.
Notes:

v Set the MIME tag/value pairs to the following:

– Tag: X-RN-VERSION:

– Value: ROSETTANET/V02.00

v Set the Content Type and SubContent to Application/RosettaNet.

v Set Sterling Gentran:Server Application as the recipient.

2 Add the RosettaNet delivery agent configured for inbound to this mailbox.
See Creating RosettaNet Mailboxes for Inbound RNIF 1.1 and 2.0 for more
information.

RNIF 1.1 and 2.0 outbound

This table describes the Sterling Gentran:Server for RosettaNet outbound data flow.

Note: See the IBM Sterling Gentran:Server for Microsoft Windows HTTP Message
Forwarder Configuration Guide for instructions on configuring the HTTP Message
Forwarder.

Chapter 4. Using the Security Profile Manager and Communication Tasks 61



Stage Description

1 Create a new HTTP Gateway mailbox configured to send messages.
Note: Set the destination URL to your trading partner’s URL.

2 Add the RosettaNet delivery agent configured for outbound to this mailbox.
See Creating the RosettaNet Mailbox for Each Outbound Trading Partner for
more information.

3 The system looks at the agency and, if the agency is RosettaNet, it sorts all
documents and sends Receipt Acknowledgements first, and then sends all
remaining documents.

RosettaNet Security Profile Manager Properties
The RosettaNet Security Profile Manager enables you to administer the certificates
required to encrypt, decrypt, sign, and verify messages as they flow in and out of
Sterling Gentran:Server.

The Security Profile Manager only resides on the Sterling Gentran:Server Mailbox
Server, and is responsible for managing the digital certificate on that machine. The
nature of certificate management makes it impossible to remotely administer these
functions.

Importing or creating a certificate

When you import a certificate or create a self-signed certificate, it is associated
with a Sterling Gentran:Server EDI code to ensure it uses the appropriate certificate
on the documents flowing through the system. To facilitate the process of
associating the trading partner ID and the digital certificate, you are presented
with a list of existing partners and the EDI codes for those partners. If you want to
associate a certificate with a trading partner ID not associated with a partner in
your system, you can type in the trading partner ID you desire.

Notes:

v When you create a self-signed certificate using the Security Profile Manager and
when you are creating the information necessary to purchase a certificate, you
must be logged onto the system and onto Sterling Gentran:Server using the
same User ID and password under which the Sterling Gentran:Server Mailbox
service runs. This is necessary because when the certificate is used during
decryption or digital signature generation, the private key used for these
operations is restricted to the User ID and password that created it.

v The importing and exporting of certificates with private keys is intended for use
inside this application alone. However, it may work with applications that
support PKCS #12.

Removing a certificate

The Security Profile Manager also allows you to remove certificates and the related
entry in the security profile from a system.

Exporting a certificate

The Security Profile Manager also exports certificates to facilitate sending public
keys to trading partners and moving certificates from one server to another inside
your enterprise.
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The importing and exporting of certificates with private keys is intended for use
inside this application alone. However, it may work with applications that support
PKCS #12.

Security Profile Manager Browser
The Security Profile Manager browser enables you to administer the certificates
required to encrypt, decrypt, sign, and verify messages as they flow in and out of
Sterling Gentran:Server.

The Security Profile Manager only resides on the Sterling Gentran:Server Mailbox
Server, and is responsible for managing the certificates on that machine. The nature
of certificate management makes it impossible to remotely administer these
certificates.

This illustration shows an example of the Security Profile Manager browser.

This table describes the parts of the Security Profile Manager browser.

Part Function

Partner ID Lists the partner identifier with which the certificate is associated.
Note: Only one partner/certificate entry may be selected at a time.

Certificate
Distinguished Name

Lists the common name of the certificate.

Signing Indicates whether the certificate is used for digital signatures.

Encrypting Indicates whether the certificate is used for data encryption.

Create Displays the Create Self-Signed Certificate Dialog Box to enable you
to create a certificate that is registered and linked to a specified
trading partner ID.

If the Trading Partner ID is an EDI code in the Sterling
Gentran:Server Partner_tb database table then the certificate is also
linked to the associated partner name.

Import Displays the Import Certificate Dialog Box to allow you to import a
certificate from a trusted certificate authority, a public certificate
from a trading partner, or a certificate that you previously exported
from the Security Profile Manager.
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Part Function

Export Displays a message dialog box that enables you to select whether
the selected certificate is exported to a PKCS#12 certificate that can
be used to propagate a private key between Sterling Gentran:Server
communication controllers in your enterprise (select yes) or exported
to a DER-encoded certificate to be distributed to your trading
community and used as a public key (select no).

Remove Removes the selected certificate (and removes the entry from the
security profile).

You must confirm the removal prior to its execution.

Create Self-Signed Certificate Dialog Box
The Create Self-Signed Certificate dialog box enables you to create a certificate that
is registered and linked to a specified trading partner ID.

When you create a self-signed certificate using the Security Profile Manager and
when you are creating the information necessary to purchase a certificate, you
must be logged onto the system and onto Sterling Gentran:Server using the same
User ID and password under which the Sterling Gentran:Server Mailbox service
runs. This is necessary because when the certificate is used during decryption or
digital signature generation, the private key used for these operations is restricted
to the User ID and password that created it.

If the Trading Partner ID is an EDI code in the Sterling Gentran:Server Partner_tb
database table then the certificate is also linked to the associated partner name.

This illustration shows an example of the Create Self-Signed Certificate dialog box.
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This table describes the parts of the Create Self-Signed Certificate dialog box.

Part Function

Partner ID for
Self-Signed
Certificate

Lists the partner identifier from the Sterling Gentran:Server Partner
Editor with which the certificate is associated.

Certificate Purpose Indicates the purpose of the certificate:

v Digital Signature

v Data Encryption

v Both

Common Name Specifies the common name of the certificate.

Organization Specifies the organization for the certificate.

Country Specifies the 2-character code of the country where the certificate
originated.

Email Address Specifies the contact E-mail address for the certificate.

Import Certificate Dialog Box
The Import Certificate dialog box allows you to import a certificate from a trusted
certificate authority, a public certificate from a trading partner, or a certificate that
you previously exported from the Security Profile Manager.

This illustration shows an example of the Import Certificate dialog box.

This table describes the parts of the Import Certificate dialog box.

Part Function

Partner ID for
import certificate

Lists the partner identifier from the Sterling Gentran:Server Partner
Editor with which the certificate is associated.
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Part Function

Type of certificate to
import

Indicates the type of certificate that you are importing. Value options
are:

v Import a public certificate (this is the default)

v Import certificate with a private key associated with it

Note: If you are using Sterling Gentran:Server for RosettaNet on a
Windows machine, this option is disabled.

Select how the
certificate can be
used

Specifies the manner in which the certificate can be used:

v Verify digital signatures

v Encrypt data

v Both

Note: These options are disabled if you are importing a private
certificate.

Creating a Self-Signed Certificate
The Security Profile Manager enables you to create a certificate that is registered
and linked to a specified trading partner ID.

Before you begin

Note: When you create a self-signed certificate using the Security Profile Manager
and when you are creating the information necessary to purchase a certificate, you
must be logged onto the system and onto Sterling Gentran:Server using the same
User ID and password under which the Sterling Gentran:Server Mailbox service
runs. This is necessary because when the certificate is used during decryption or
digital signature generation, the private key used for these operations is restricted
to the User ID and password that created it.

About this task

Note: If the Trading Partner ID is an EDI code in the Sterling Gentran:Server
Partner_tb database table then the certificate is also linked to the associated partner
name.

Use this procedure to create a new self-signed certificate.

Procedure
1. From the Windows Start menu, select Programs > Gentran Server > Gentran

RosettaNet Management Console.
2. Click Security Profile Manager.
3. Click Create.

The system displays the Create Self-Signed Certificate Dialog Box.
4. From the Partner ID for self-signed certificate list, select the partner identifier

from the Sterling Gentran:Server Partner Editor with which the certificate is
associated.

5. From the Certificate Purpose section, select the option corresponding to the
purpose of the certificate.

6. In the Common Name box, type the common name for the certificate.
7. In the Organization box, type the organization name for the certificate.
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8. In the Country box, type the 2-character code of the country of the certificate’s
origin.

9. In the Email address box, type the contact’s E-mail address for the certificate.
10. Click OK.

The system saves the certificate information and displays a message box
informing you that the creation of the self-signed certificate was successful.

Note: Refresh the display to enable the view to reflect work that may be
performed on the certificates by other applications.

11. Click OK.

Deleting a Certificate
About this task

Use this procedure to delete a certificate from the local certificate store and from
the security profile.

Procedure
1. From the Windows Start menu, select Programs > Gentran Server > Gentran

RosettaNet Management Console.
2. Click Security Profile Manager.
3. From the list, select a partner ID and click Remove.

You are prompted to confirm the delete.
4. Click Yes to confirm the delete.

If you are attempting to delete a certificate with a private key, the system
prompts you to delete the private key.

5. Click Yes to confirm the delete of the private key.

Importing a Certificate
When you import a certificate or create a self-signed certificate, it is associated
with a Sterling Gentran:Server EDI code to ensure it uses the appropriate certificate
on the documents flowing through the system. To facilitate the process of
associating the trading partner ID and the digital certificate, you are presented
with a list of existing partners and the EDI code for that partner. If you want to
associate a certificate with a trading partner ID not associated with a partner in
your system, you can type in the trading partner ID you desire.

About this task

The importing certificates with private keys is intended for use inside this
application alone. However, it may work with applications that support PKCS #12.

Use this procedure to import a certificate.

Procedure
1. From the Windows Start menu, select Programs > Gentran Server > Gentran

RosettaNet Management Console.
2. Click Security Profile Manager.
3. Click Import.

The system displays the Import Certificate Dialog Box.
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4. From the Partner ID for imported certificate list, select the partner identifier
from the Sterling Gentran:Server Partner Editor with which the certificate is
associated.

5. From the Select the type of certificate to import section, select the option for
the type of certificate that you are importing.

6. If you are importing a public certificate, from the Select how the public
certificate can be used section, select the manner in which the certificate can
be used.

7. Click OK.
The system saves the information and displays the Filename for Certificate
Import Dialog Box.

8. Enter or select the location of the certificate.
9. Click Open.

The system confirms that the import is complete.
10. Click OK to complete the import process.

The certificate is registered with the selected partner ID and the function or
functions you specified that the certificate will perform.

Exporting a Certificate
About this task

Use this procedure to export a certificate.

Procedure
1. From the Windows Start menu, select Programs > Gentran Server > Gentran

RosettaNet Management Console.
2. Click Security Profile Manager.
3. Select the certificate you wish to export and click Export.

The system displays a message dialog box that enables you to select whether
the certificate is exported to a PKCS#12 certificate that can be used to
propagate a private key between Sterling Gentran:Server communication
controllers in your enterprise or exported to a DER-encoded certificate to be
distributed to your trading community and used as a public key.

4. Do one of the following:
v To export the certificate to a PKCS#12 certificate that can be used to

propagate a private key between Sterling Gentran:Server communication
controllers in your enterprise, click Yes. Continue with Step 5.
The system displays the Filename for Private Key Certificate Export Dialog
Box.

v Export the certificate to a DER-encoded certificate to be distributed to your
trading community and used as a public key, click No. Continue with Step
8.
The system displays the Filename for Public Certificate Export Dialog Box.

5. Enter or select the export file name.
The system automatically adds the .PFX or .P12 extension.

6. Click Save to export the certificate.
The system confirms that the export is complete.

7. Click OK to complete the export process.
8. Enter or select the export file name.
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The system automatically adds the .CER or .CRT extension.
9. Click Save to export the certificate.

The system prompts you with a message box asking if you want this
certificate to be in DER encoded binary X.509 format or base64 encoded.

10. Do one of the following:
v If you want this certificate to be in DER encoded binary X.509 format, click

Yes and continue with Step 11.
The system confirms that the export is complete.

v If you want the certificate to be base64 encoded), click No and continue
with the next step.
The system confirms that the export is complete.

11. Click OK to complete the export process.

Creating the RosettaNet Mailbox for Each Outbound Trading Partner
You must create a RosettaNet gateway mailbox for the system to use to send
outbound RosettaNet messages.

About this task

Use this procedure to create a RosettaNet mailbox to send outbound messages.

Note: See the IBM Sterling Gentran:Server for Microsoft Windows Communications
User Guide for more information on the Mailbox Server Manager. See the IBM
Sterling Gentran:Server for Microsoft Windows HTTP Gateway Configuration Guide for
more information.

Procedure
1. On your communications controller, start the Mailbox Server Manager.

The system displays the Server Manager browser.
2. Expand the Mailbox Server directory tree for your controller.
3. Right-click the Mailboxes folder icon and select Create.

The system displays the Create Mailbox Wizard.
4. Type the name of the mailbox you are creating and click Next twice.

The system asks you whether you want to use the mailbox as a gateway.
5. Select Yes, use this mailbox as a gateway.
6. From the list, select HTTP Gateway and click Next.

The system displays a summary dialog box.
7. Click Finish.

The system displays the appropriate dialog box for the gateway you selected.
8. Make any necessary configuration changes and click OK to exit the dialog

box.

Note: This mailbox should send messages and you should specify a
destination URL.

9. Right-click the new mailbox and select Properties.
The system displays the Mailbox Properties dialog box.

10. Click the Delivery Rules tab.
The system displays the Delivery Rules options.
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11. Click New.
The system displays the New Delivery Rule dialog box.

12. In the Rule name box, type the name of the delivery rule.
13. From the Run this rule list, select Receiving.
14. From the Using the list, select RosettaNet Agent.
15. In the with command line box, type outbound and click OK.

The system saves the rule and return to the Delivery Rules tab of the Mailbox
Properties dialog box.

16. Click OK.
The system exits the Mailbox Properties dialog box.

Implementing Optional Features on Outbound Mailboxes for RNIF 2.0
Messages

By default, all XML data in outbound RNIF 2.0 messages are base64 encoded when
sent. You can turn off this encoding (so the data is readable) by adding a delivery
rule parameter to each outbound mailbox that you want affected.

About this task

After turning off the base64 encoding, the XML data will be in UTF-8 format
(instead of UTF-16) and 7-bit encoded (instead of base64), similar to how RNIF 1.1
messages are formatted. Because 7-bit is the default encoding format for MIME, the
"Content-Transfer-Encoding" MIME header field will not be included in the
outbound message.

Note: See the IBM Sterling Gentran:Server for Microsoft Windows Communications
User Guide for more information.

Use this procedure to turn off base64 encoding for RNIF 2.0 messages on outbound
mailboxes. Complete this procedure for each mailbox for which you want base64
encoding turned off.

Procedure
1. Right-click the mailbox and select Properties.

The system displays the Mailbox Properties dialog box.
2. Click the Delivery Rules tab.

The system displays the Delivery Rules options.
3. Click Edit.

The system displays the Edit Delivery Rule dialog box.
4. In the with command line box after outbound, type no-base64 (preceded by a

space) and click OK.
The system saves the rule and return to the Delivery Rules tab of the Mailbox
Properties dialog box.

5. Click OK.
The system exits the Mailbox Properties dialog box.
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Implementing Optional Features on Outbound Mailboxes for RNIF 1.1
Messages

Some RosettaNet solution providers are incorrectly requiring a special MIME
header field ("MIME-Version: 1.0") in RNIF 1.1 messages. HTTP is not MIME
compliant so it is incorrect to use the MIME Version number tag on HTTP
messages.

About this task

If the solution provider of your trading partner does not change the requirement,
you can opt to add this MIME tag to the outbound RNIF 1.1 messages to this
trading partner. To activate this feature, you need to add a delivery rule parameter
to the outbound mailbox for that trading partner.

Use this procedure to add MIME-version tag to RNIF 1.1 messages on outbound
mailboxes. Complete this procedure for each mailbox for which you want to have
the MIME-version tag added.

Procedure
1. Right-click the new mailbox and click Properties. See the IBM Sterling

Gentran:Server for Microsoft Windows Communications User Guide for more
information.
The system displays the Mailbox Properties dialog box.

2. Click the Delivery Rules tab.
The system displays the Delivery Rules options.

3. Click Edit.
The system displays the New Delivery Rule dialog box.

4. In the with command line box after outbound, type mime-version (preceded by
a space) and click OK.
The system saves the rule and return to the Delivery Rules tab of the Mailbox
Properties dialog box.

5. Click OK.
The system exits the Mailbox Properties dialog box.

Creating RosettaNet Mailboxes for Inbound RNIF 1.1 and 2.0
You must create a RosettaNet gateway mailbox for the system to use to receive
inbound RosettaNet messages. If you are receiving both RNIF 1.1 and RNIF 2.0
messages, you must create one mailbox for each RosettaNet version.

About this task

Note: See the IBM Sterling Gentran:Server for Microsoft Windows Communications
User Guide for more information. Also see the IBM Sterling Gentran:Server for
Microsoft Windows HTTP Gateway Configuration Guide.

Use this procedure to create a RosettaNet mailbox to receive inbound messages.

Procedure
1. On your communications controller, start the Mailbox Server Manager.

The system displays the Server Manager browser.
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2. Expand the Mailbox Server directory tree for your controller.
3. Right-click the Mailboxes folder icon and select Create.

The system displays the Create Mailbox Wizard.
4. Type the name of the mailbox you are creating and click Next twice.

The system asks you whether you want to use the mailbox as a gateway.
5. Select Yes, use this mailbox as a gateway.
6. From the list, select HTTP Gateway and click Next.

The system displays a summary dialog box.
7. Click Finish.

The system displays the dialog box for the gateway you selected.
8. Make any necessary configuration changes and click OK to exit the dialog

box. See RNIF 1.1 inbound and RNIF 2.0 inbound for more information.
9. Right-click the new mailbox and select Properties.

The system displays the Mailbox Properties dialog box.
10. Click the Delivery Rules tab.

The system displays the Delivery Rules options.
11. Click New.

The system displays the New Delivery Rule dialog box.
12. In the Rule name box, type the name of the delivery rule.
13. From the Run this rule list, select Sending.
14. From the Using the list, select RosettaNet Agent.
15. In the with command line box, type inbound and click OK.

The system saves the rule and return to the Delivery Rules tab of the Mailbox
Properties dialog box.

16. Click OK.
The system exits the Mailbox Properties dialog box.
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Chapter 5. Using the PIP Profiler

About the PIP Profiler
A PIP definition is the RosettaNet-defined set of properties that identify a PIP. A
PIP profile is the addition of your individual specifications to a RosettaNet PIP.

A PIP profile includes:
v the partner identity
v your role and the role of the partner with whom the PIP is exchanged
v PIP Name
v PIP version
v RNIF version
v The sequenced messages that make up the process

Notes:

v For Sterling Gentran:Server for RosettaNet version 5.3, the PIP Profiler enhances
and replaces the PIP Decision Editor from previous releases.

v The XML standards must be defined before you are able to use the PIP Profiler.

The PIP Profiler is a component of Sterling Gentran:Server for RosettaNet that
enables you to set up PIP profiles for RosettaNet processing, and thus set business
rules by which PIPs will be executed and monitored with your trading community.

The PIP Profiler enables you to modify PIP properties from predefined RosettaNet
PIP definitions (in the PIPDef_tb database table). The PIP Profiler then uses this
information to populate the PIPProfile_tb database table after you update it to
meet your business needs.

If you select "Any" for a profile, then any trading partner can trade that PIP under
this profile. If the same version of the same PIP has two profiles, one for "Any"
and the other for a specific partner, the specific partner profile takes precedence.

See About Database Tables for more information about the PIPProfile_tb database
table.

PIP Profiler functions

You must use the PIP Profiler to create the profile for each PIP you exchange with
your trading partners.

The PIP Profiler enables you to set up PIP profile properties according to your
RosettaNet processing needs. You can specify:
v the partner identity
v your role and the role of the partner with whom the PIP is exchanged
v PIP Name
v PIP version
v RNIF version
v the sequenced messages that make up the process
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For each message you can specify the following:
v global business code
v sequence number of another message in the PIP on which this message depends

and to which this message refers
v whether this is the last message in a PIP
v whether a digital signature is used
v number of retries
v direction of message
v message time-out threshold
v message warning threshold
v encryption content (i.e., none, payload, payload container)
v encryption algorithm

The PIP Profiler also enables you to:
v Revert to a previously saved version of a PIP profile.
v Delete a PIP profile.

Components

This table describes the PIP Profiler components.

Part Function

PIP Profiler browser Enables you to:

v Use a RosettaNet- or user-defined PIP as a template to
create a profile for each PIP exchanged with your trading
partners.

v Modify and save your PIP profiles.

v Import PIP profiles.

v Export PIP profiles.

v Delete PIP profiles.

New Profile dialog box Enables you to specify:

v partner name

v role

v PIP name

v PIP version

v RNIF version

Document Properties dialog
box

Enables you to:

v View the properties of a selected message.

v Add a message to the PIP sequence and designate
properties for that message.

v Modify properties for a selected message.

PIP Profiler Browser
You use the PIP Profiler browser to create PIP profiles for RosettaNet processing.

For ease of use, the PIP Profiler allows you to access its functions from menus and
a toolbar/button bar (you can toggle the display of the toolbar and button bar).
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The PIP Profiler browser enables you to select a specific Partner, PIP, PIP version,
and role combination, and Sterling Gentran:Server for RosettaNet displays a
default list of sequenced messages for the selected PIP. The steps listed include the
following information:
v the sequence of messages in the PIP
v the time allowed for each message to process
v the step number of a message that must complete successfully before the

selected message can be sent
v the direction of the message (sending or receiving)
v the number of times the system will attempt to send the message
v whether the message is the last step in the PIP

This diagram illustrates the PIP Profiler browser.

This table describes the parts of the PIP Profiler browser.

Part Function

Partner Specifies the name of the trading partner.

The Partner list contains the names of trading partners that have
partner profiles completed through the Partner Editor. You can not
create a PIP profile for trading partners that do not have a partner
profile.

Our Role Specifies whether you are initiating this PIP or responding to a PIP
initiated by your trading partner.

PIP Name Specifies the RosettaNet-defined PIP identification number.

Access the www.Rosettanet.org website for information about specific
RosettaNet PIPs.

PIP Version Specifies the RosettaNet-defined version number of the PIP.

RNIF Version Specifies the version of the RNIF.
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Part Function

(lower pane) Contains the sequence of messages in the PIP.

Sterling Gentran:Server for RosettaNet does not display the sequenced
list until you select a partner from the upper pane.

Insert
Accesses the Document Properties Dialog Box, which enables you to
add a message to the existing sequence of messages for this PIP, and
define the properties for that message.

When you add a message to the PIP sequence, Sterling Gentran:Server
for RosettaNet renumbers the sequence steps according to the order
specified through the Document Properties dialog box.

Edit
Accesses the Document Properties Dialog Box, which enables you to
view or modify the properties for the selected message.

Remove
Deletes the selected message from the sequence list.

When you delete a message from the sequence list, Sterling
Gentran:Server for RosettaNet renumbers the steps according to the
order specified through the Document Properties Dialog Box.

Undo all
Cancels any changes made since the last time the PIP sequence was
saved, and reverts to the previously saved sequence.

Default
Replaces the current sequence with the default RosettaNet-defined
message sequence for the selected PIP, regardless of any changes you
may have made.

The system displays a message to warn you that loading the default
sequence replaces the message list.

Sterling Gentran:Server for RosettaNet stores default PIP information
in the PIPProfile_tb database table.

See About Database Tables for more information about the
PIPProfile_tb database table.

Step Indicates the processing order of the messages in the list.

Global Business
Code

Specifies a RosettaNet-defined message name.

Examples:

v Purchase Order Request Action

v Receipt Acknowledge

Timeout/Action Specifies the length of time allowed for this message to be sent, or the
action of the message.

Warning Specifies the warning threshold for this message.

From step Specifies the sequence number of another message in the PIP on which
this message depends and to which this message refers.

Direction Specifies whether you are sending or receiving this message.

Number of Retries Specifies the number of times the system will attempt to send this
message.

Last Step Specifies whether this message is the last step in the process.

Encryption
Content

Specifies the encryption content:

v none

v Payload

v Payload Container
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Part Function

Encryption
Algorithm

Specifies the algorithm for encryption:

v TripleDES

v RC2

Signature Indicates (if checked) that a digital signature is used with this
message.

New Profile Dialog Box
The New Profile dialog box enables you to create a new PIP Profile.

This diagram illustrates the New Profile dialog box.

This table describes the parts of the New Profile dialog box.

Part Function

Partner Name Specifies the name of the trading partner.

The Partner list contains the names of trading partners that have
partner profiles completed through the Partner Editor. You can not
create a PIP profile for trading partners that do not have a partner
profile in Sterling Gentran:Server.

If you select "Any," this profile may be used with any partner. If the
same version of the same PIP has two profiles, one for "Any" and the
other for a specific partner, the specific partner profile takes
precedence.

Our Role Specifies whether you are initiating this PIP or responding to a PIP
initiated by your trading partner.

PIP Name Specifies the RosettaNet-defined PIP identification number.

Access the www.Rosettanet.org website for information about specific
RosettaNet PIPs.
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Part Function

PIP Version Specifies the RosettaNet-defined version number of the PIP.

The versions in this list depend on which PIP Name you selected.

RNIF Version Specifies the version of the RNIF:

v 1.1

v V02.00

Document Properties Dialog Box
The Document Properties dialog box enables you to:
v view the properties of a selected message
v add a message to the PIP sequence and designate properties for that message
v modify properties for a selected message

This diagram illustrates the Document Properties dialog box.

This table describes the parts of the Document Properties dialog box.

Part Function

Global Business Code Specifies the RosettaNet-defined message name.

Examples:

v Purchase Order Request Action

v Receipt Acknowledge

Step Specifies the sequence number indicating the processing
order of this message in the PIP.

Last Step Indicates whether this message is the last step in the PIP
process.

From Step Specifies the sequence number of another message in the PIP
on which this message depends and to which this message
refers.

Number of Retries Specifies the number of times the system will attempt to
send this message.

Signature Indicates (if checked) that a digital signature is used with
this message.

Direction Specifies whether you are sending or receiving this message.
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Part Function

Timeout Specifies the length of time by which the message must be
sent in number of hours and minutes.

Warning Specifies the length of time by which a warning must be sent
if a message is approaching a point of error, in number of
hours and minutes.

Content Specifies the encryption content. Valid values are:

v none

v Payload

v Payload Container

This list is unavailable if you are using RNIF version 1.1.

Algorithm Specifies the algorithm for encryption. Valid values are:

v TripleDES

v RC2

Note:

v This list is unavailable if you select "none" in the
Encryption Content list.

v This list is unavailable if you are using RNIF version 1.1.

v The direction of the message is "Receiving."

Creating a PIP Profile
You must use the PIP Profiler to create a PIP profile for each PIP you exchange
with your trading partners. You can create either RosettaNet-defined PIP profiles
or PIP profiles that you previously created.

Before you begin

Before you create a PIP profile, you must first create a partner profile for the
partner with whom you are exchanging the PIP (if you have not already done so).

About this task

Note: See the Rosettanet website for information about specific RosettaNet PIPs.

Use this procedure to create a new PIP profile.

Procedure
1. From the Windows Start menu select Programs > Gentran Server > Gentran

RosettaNet Management Console and click PIP Profiler.
The system displays the PIP Profiler Browser.

2. Click New.
The system displays the New Profile Dialog Box.

3. From the Partner list, select the name of the trading partner with whom this
PIP will be exchanged, or select Any if you want this profile to be available
for use with all trading partners.

Note: The Partner list contains the names of trading partners that have
partner profiles completed through the Partner Editor. You can not create a
PIP profile for trading partners that do not have a partner profile.
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4. Select your role (whether you are initiating or receiving the PIP).
5. Select the identifying number of the PIP you want to use as a template for

creating the PIP profile.
6. Select the appropriate version of the specified PIP.
7. Select the appropriate RNIF version.
8. Click OK to create the profile.

The system returns you to the PIP Profiler Browser.
9. To modify any of the messages in the list, double-click the message and

continue with the next step. Otherwise, continue with step 12.
The system displays the Document Properties Dialog Box for the message you
selected.

10. Modify the desired message properties and click OK.
The system saves the properties of the message, exits the Document Properties
dialog box, and displays the PIP Profiler Browser. The lower pane is now
populated with information from the PIPDef_tb database table, which you can
create as needed.

11. To add any messages to the list, click Insert and continue with the next step.
Otherwise, continue with step 15.
The system displays the Document Properties Dialog Box.

12. Select the desired properties for the new message and click OK.
The system saves the properties of the new message, exits the Document
Properties dialog box, and displays the PIP Profiler browser with the new
message in the list. The system renumbers the sequence of the messages
according to the placement of the messages you add.

13. To delete any messages from the sequence for this PIP, select the message you
want to delete and click Remove.
If you delete or change something by mistake, click Undo all before saving
the PIP Profile to cancel any changes made since the last time the PIP
sequence was saved.

Note: The system may prompt you that deleting this message will break the
links between this step and the dependent steps. Click Yes to delete the
message or No to cancel the delete operation. If you click Yes, the system
deletes the selected message from the list and renumbers the message
sequence accordingly.

14. Click Save to save the properties for the selected PIP profile.

Editing PIP Profile Information
About this task

Use this procedure to edit PIP profile information.

Procedure
1. From the Windows Start menu select Programs > Gentran Server > Gentran

RosettaNet Management Console and then click PIP Profiler.
The system displays the PIP Profiler Browser.

2. From the upper pane, select the PIP profile you want to modify and then select
the step you want to modify in the lower pane and click Edit.
The system displays the Document Properties Dialog Box for the message you
selected.
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3. Modify the desired message properties and click OK.
The system saves the properties of the message, exits the Document Properties
dialog box, and displays the PIP Profiler Browser.

4. To add messages to the list, click Insert and continue with the next step.
Otherwise, continue with step 6.
The system displays the Document Properties Dialog Box.

5. Select the desired properties for the new message and click OK.
The system saves the properties of the new message, exits the Document
Properties dialog box, and displays the PIP Profiler browser with the new
message in the list. The system renumbers the sequence of the messages
according to the placement of the messages you add.

6. To delete any messages from the sequence for this PIP, select the message you
want to delete and click Remove.
The system prompts you that deleting this message will break the links
between this step and the dependent steps. Click Yes to delete the message or
No to cancel the delete operation. If you click Yes, the system deletes the
selected message from the list and renumbers the message sequence
accordingly.

Note: If you delete or change something by mistake, prior to saving the PIP
Profile, click Undo all to cancel any changes made since the last time the PIP
sequence was saved, and revert to the previously saved sequence. The system
will ask you if you want to load the last saved version of the PIP profile from
the database (click Yes).

7. Click Save to save the properties for the selected PIP profile.

Reverting to the Default RosettaNet PIP Profile
The PIP Profiler enables you to change a PIP profile back to the default RosettaNet
properties. You may want to use this function if you need to correct an error made
while customizing the PIP, such as accidentally deleting a message from the
sequence.

About this task

Use this procedure to revert to the default RosettaNet PIP profile.

Procedure
1. From the Windows Start menu select Programs > Gentran Server > Gentran

RosettaNet Management Console and click PIP Profiler.
The system displays the PIP Profiler Browser.

2. From the upper pane, select the appropriate PIP profile.
3. Click Default.

The system asks you to be certain you want to load the default list from the
database, as this will overwrite anything you created.

4. Click Yes.
The system replaces the message list with the default RosettaNet sequence for
the selected PIP.

5. Click Save to save the properties for the selected PIP profile.
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Deleting a PIP Profile
The PIP Profiler enables you to delete a PIP profile.

About this task

You may want to delete a PIP profile for either of the following reasons:
v You no longer exchange messages with this trading partner.
v You no longer need to define properties for a specific PIP because your

processing requirements changed.

Notes:

v When you use this function, it only removes the PIP profile from the system; the
default RosettaNet PIP definition is not deleted.

v See About Database Tables for more information about the PIPProfile_tb
database table.

Use this procedure to delete a PIP profile.

Procedure
1. From the Windows Start menu select Programs > Gentran Server > Gentran

RosettaNet Management Console and click PIP Profiler.
The system displays the PIP Profiler Browser.

2. From the upper pane, select the appropriate PIP profile.
3. Click Delete.

The system asks you to be certain you want to delete the PIP profile.
4. Click Yes.

The system deletes the PIP profile from the PIPProfile_tb database table.

Importing a PIP profile
This function enables you to import a PIP Profile. You must have already exported
a PIP profile to use this function.

About this task

Note: This function facilitates moving from test to production environments.

Use this procedure to import a PIP profile.

Procedure
1. From the Windows Start menu select Programs > Gentran Server > Gentran

RosettaNet Management Console and click PIP Profiler.
The system displays the PIP Profiler Browser.

2. Click Import.
The system displays the Open Dialog Box.

3. Enter or select the location of the PIP profile.
v The default directory for RosettaNet PIP profile imports is

GENSRVNT\RosettaNet\Profiles.
v The default file extension for RosettaNet PIP profiles is .RNP.

4. Click Open.
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The system confirms that the import is complete.
5. Click OK to complete the import process.

Exporting a PIP profile
This function enables you to export a PIP profile.

About this task

Note: This function facilitates moving from test to production environments.

Use this procedure to export a PIP profile.

Procedure
1. From the Windows Start menu select Programs > Gentran Server > Gentran

RosettaNet Management Console and click PIP Profiler.
The system displays the PIP Profiler Browser.

2. From the upper pane, select the PIP profile to export and click Export.
The system displays the Save As Dialog Box.

3. Enter a name for the export file and select a location.
v The default directory for RosettaNet PIP profile exports is

GENSRVNT\RosettaNet\Profiles.
v The system automatically prompts you with the .RNP extension.

4. Click Save to export the PIP profile.
The system confirms that the export is complete.

5. Click OK to complete the export process.
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Chapter 6. Using the PIP Instance Viewer

About the PIP Instance Viewer
A PIP instance is any RosettaNet message that is processed by the Sterling
Gentran:Server for RosettaNet.

This is the PIP Instance Viewer, which is a component of Sterling Gentran:Server
for RosettaNet that allows you to view all the RosettaNet documents and the
details that were in the Preamble, Delivery Header (for RNIF 2.0 messages only),
and Service Header of the message. This allows you to see the completeness of
PIPs as well as their status. The PIP Instance Viewer enables you to:
v Identify the PIP to which a message belongs using the preamble and service

header information.
v Verify PIP status.
v Delete selected PIPs from the PIPTrack_tb database table.
v Confirm detailed PIP information for a message.

When you or your trading partner initiate a PIP, the Sterling Gentran:Server for
RosettaNet stores preamble and service header information from the first message
of the PIP in the PIPTrack_tb database table. The system applies the same
preamble, delivery header (for RNIF 2.0 messages only), and service header
information from that message to all remaining messages in the PIP.

See About Database Tables for information about the PIPTrack_tb database table.

PIP instance data

The PIP Instance Viewer enables you to view detailed information about a selected
message, including:
v processing status
v instance IDs (from the service header)
v business process specifics
v type of action
v processing time allotted
v sending and receiving partner roles and IDs
v global codes (from the preamble)

Within the PIP Instance Viewer display, the PIP instances are sorted alphabetically
by partner and then within each partner it is sorted by Document Identity Instance
ID. The PIP Instance Key number is a sequence number assigned to the PIP
instance by Sterling Gentran:Server for RosettaNet to uniquely identify that PIP
instance. This number is not associated with any PIP.

To determine which messages are part of one PIP, look for messages with the same
document identity instance ID.
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Components

The PIP Instance Viewer consists of the PIP Instance Viewer browser. This browser
enables you to:
v delete selected PIPs from the PIPTrack_tb database table
v view the following information for a PIP instance:

– date/time
– the partner associated with the PIP
– PIP name and description
– PIP instance
– whether the PIP instance was sent or received
– processing status
– document identity instance ID
– attempt count

v display the detailed information for the PIP instance
v display the XML for the instance selected in the left pane (if available)

PIP Instance Viewer Browser
You use the PIP Instance Viewer browser to view preamble and service header
information for individual messages within a PIP.

This diagram illustrates the PIP Instance Viewer browser, displaying PIP details.

This diagram illustrates the PIP Instance Viewer browser, displaying document
(message) details.

Information organization

The information on the PIP Instance Viewer browser is organized in a hierarchical
manner, described in the following table.
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Level
selected (left
pane) How to access Information displayed (right panes)

Partner Open PIP Instance
Viewer browser

Displays the PIPs for the selected partner.

PIP Open Partner node and
select a PIP

Displays the PIPs for the selected partner.

v Document Name

v Date-Time Stamp

v Document IID (Document Instance Identifier)

v Attempt Count

If any of these components are missing or not
appropriate for a particular interchange, they are
not displayed.

Document
(Message)

Open PIP node and
select a message

The upper right pane, displays the detail
information for the selected message.

The lower right pane, displays the XML for the
instance selected in the left pane (if available).

Parts and functions

This table describes the parts of the PIP Instance Viewer browser.

Part Function

(left pane—PIP
Instance tree view)

Displays an alphabetically organized hierarchical list of all the
partners, PIPs, PIP Instance IDs (PIP IIDs), and documents
(messages) that were sent or received.

See Information organization for more information on contents at
each level. See PIP Instance Viewer tree view icons for more
information on status icons.

(upper right
pane—detailed list
view)

Displays a detailed list of the selected PIP or document. The
information displayed depends on the level.

(lower right
pane—HTML view)

Displays the XML for the instance selected in the left pane (if
available).
Note:

v This option is only available if a single item is selected from the
detailed list.

v This option is only available if there is a file associated with the
document (message) in the Sterling Gentran:Server IntIn or
IntOut folder.

Upper right pane (Partner selected in left pane)

PIPs Displays sequence number assigned by Sterling Gentran:Server for
RosettaNet to uniquely identify the PIP instance.

v The PIP Instance Key number is not associated with the PIP to
which the message belongs.

v Multiple messages from a single PIP all have the same document
identity instance ID.

See PIP Instance Viewer tree view icons for more information on
PIP Instance Viewer status icons.
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Part Function

Upper right pane (PIP selected in left pane)

PIP IID Displays the PIP IID assigned by Sterling Gentran:Server for
RosettaNet to uniquely identify the PIP instance.
Note:

v The PIP IID number is not associated with the PIP to which the
message belongs.

v Multiple messages from a single PIP all have the same document
identity instance ID.

See PIP Instance Viewer tree view icons for more information on
PIP Instance Viewer status icons.

Document Name Displays a unique ID from the service content of the selected
message.

Date-time stamp Displays the date and time of the message from the preamble, in
ISO 8601 format.

YYYYMMDDTHHMMSS.SSSZ

Where:

v YYYY = the year

v MM = the month

v DD = the day

v T = a separator between the date and time

v HH = the hour

v MM = the minute

v SS = the second

v .SSS = the hundredths of a second

v Z = the end of the date/time indicator

Document Identity
Instance ID

Displays the unique PIP identifier from the document identity
portion of the service header.

Every message in a single PIP has the same document identity
instance ID.

Attempt Count v For outbound messages, indicates the number of times Sterling
Gentran:Server for RosettaNet attempted to send the message.

v For inbound messages, indicates the number of times the
message was received by the partner.

Upper right pane (message selected in left pane)

This pane displays specific information from the preamble, delivery header, and service
header of the selected document.

PIP Instance Viewer tree view icons

This table lists the icons that the system may use in the tree view (left pane) of the
PIP Instance Viewer browser.

Each PIP Instance Identifier (PIP IID) can contain one or more messages, and each
document has a status value, which determines which icon is displayed in the tree
view. If any document under a PIP IID has a status of "closed," the "Closed" icon is
displayed for that PIP IID. The order of display is as follows:
1. Closed
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2. Error
3. Warning
4. Resend
5. Open (no icon)

For example: If a PIP IID contains 3 messages which are status Error, Warning, and
Resend, respectively. In this case, the Error icon is displayed at the PIP IID level, to
notify you that there is at least one message that is in error and that no messages
for this PIP IID have a status of "closed.".

Icon Description

This is the PIP Instance Viewer root icon.

(handshake) — Signifies a partner.

(blue square) — Signifies a PIP.

(no icon) — Indicates the document status is "open."

(green sphere) — Indicates the document status is "closed."

(red sphere) — Indicates the document status is "error."

(yellow sphere) — Indicates the document status is "warning."

(yellow folder) — Indicates the document status is "resend" or indicates a PIP
IID or message.

Viewing PIP Instance Details
About this task

Use this procedure to view detailed PIP information for a selected message.

Procedure
1. From the Windows Start menu, select Programs > Gentran Server > Gentran

RosettaNet Management Console and click PIP Instance Viewer.
The system displays the PIP Instance Viewer Browser.

2. In the tree view (left pane), select the Partner, PIP, PIP IID, or message you
want to view.
The system displays the detail information for the level you selected on the
right side of the browser.

Deleting a PIP or Document
The PIP Instance Viewer delete function enables you to remove a selected PIP or
document from the PIPTrack_tb database table without using the Sterling
Gentran:Server archive function.

About this task

Notes:
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v This delete function removes the PIP from the PIP Instance Viewer and from the
database table but does not remove it from other Sterling Gentran:Server
browsers.

v You can delete multiple PIPs or documents at a time from the list view. You can
only delete one document or PIP at a time from the tree view.

v See the Using Archive and Restore section for more information on how to
archive PIP instances.

Use this procedure to remove a PIP or document from the PIPTrack_tb database
table.

Procedure
1. From the Windows Start menu, select Programs > Gentran Server > Gentran

RosettaNet Management Console and click PIP Instance Viewer.
The system displays the PIP Instance Viewer Browser.

2. In the tree view (left pane), select the PIP or document you want to remove
from the PIPTrack_tb database table and select Delete from the File menu.
The system displays a delete confirmation message.

3. Click Yes.
The system removes the selected PIPs or the documents from the PIPTrack_tb
database table.
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Chapter 7. Using Archive and Restore with RosettaNet

About the Archive and Restore Features
The Archive feature provides a record of past PIP instances. This enables you to
produce an offline archive data file of PIP data with stored parameters (archive
definitions) that you define. This archive data file can be stored long-term.

Note: You can also use Sterling Gentran:Server Process Control feature to purge
and archive data at predefined intervals. See Using Process Control in the IBM
Sterling Gentran:Server for Microsoft Windows User Guide for more information about
scheduling unattended archive sessions.

The Restore feature enables you to reprocess archived data through Sterling
Gentran:Server. This feature copies data from an archive data file back to the active
system. Restored PIP instances can be viewed using the PIP Instance Viewer.

Important: We recommend that you archive your system data on a weekly basis.
Using this feature is critical in large volume operations.

The Archive Process
The Archive feature enables you to archive Sterling Gentran:Server for RosettaNet
PIP instances.

You can completely configure the Archive feature by using stored archive
definitions. An archive definition is a set of archive parameters that you set to
specify the exact data that you want the system to archive. The system saves the
archive definition file (*.ARD file) so you can execute the same archive process
repeatedly without having to define parameters again.

The following table describes the archive process.

Stage Description

1 Define the archiving parameters (*.ARD file). The archive parameters available
depend on the type of data you are archiving. To archive PIP instances, the
available archive parameters are age and status (all, open, closed, error).

2 Execute the archive process, which creates the actual archive files (*.ARV) in
the Archive folder.

This definition can be run interactively or on a scheduled basis via Process
Control.

See Using Process Control in the IBM Sterling Gentran:Server for Microsoft
Windows User Guide or more information on executing the archive process on
a scheduled basis.

3 In the archive process, the system copies (or removes) data both from the
database tables and the system data store.
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Archive Manager
The Archive Manager is the facility through which you archive and restore data.

The Archive Manager enables you to view the following:
v Archive definition files
v Summary data about the control information that was archived
v Detailed contents of the data stored in the archive data file

The Archive Manager also provides you with a search facility that enables you to
quickly define search parameters that are used to find a specific piece of
information. The system displays the matching results. You can then select the
desired information and the system highlights it in the Archive Manager tree view.

The Archive Manager retains extensive data for the information you archive, and
enables you to easily view it.

The Archive Manager user interface uses a tree structure that displays the
hierarchical levels of the archived data. The following table lists the information
available for each level of the Archive entry for PIP Instance.

If you select the... Then you can view...

archive file at the PIP
Instance level

summary information, including the following:

v date and time the archive started

v date and time the archive ended

v number of items archived

v number of items deleted (if any)

PIP Instance v instance key

v date and time of action

v partner

v PIP

v PIP description

v direction

v status

v transaction identifier

Upper-right pane either of the following, depending on the level and type of
the selection:

v file information (start, end, number of items archived, and
if any items were deleted)

v PIP instance information

This diagram illustrates the Archive Manager, shown with the Archive tree
expanded and an archived PIP instance selected.
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The following table describes the parts of the Archive Manager.

Part Function

Create new archive definition.

Archive data.

Mark selected item to be restored to the system.

Restore marked data to the system.

Left pane Enables you to archive, view, and restore data.

Upper right pane The display depends on the level and type of the selection, and
for PIP instances it contains one of the following:

v file information (start, end, number of items archived, and if
any items were deleted)

v PIP Instance information
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PIP Archive Definition Dialog Box
This diagram illustrates the PIP Archive Definition dialog box.

The following table describes the parts of the PIP Archive Definition dialog box.

Part Function

Name Specifies the name of the archive definition file.

This name must be unique.

Delete Data After
Archive

Indicates that the system removes the message data from Sterling
Gentran:Server for RosettaNet after archiving the data.

Add Accesses the PIP Instance Selection Criteria Dialog Box and
enables you to define new archive criteria.

Edit Accesses the PIP Instance Selection Criteria Dialog Box for the
selected PIP Instance criteria and enables you to modify the
archive criteria.

Delete Deletes the selected PIP Instance criteria from the system.

The system removes the criteria without prompting you to
confirm the deletion.

Days Old Specifies the age (in days) of the PIP Instance files to be
archived.

PIP Status Specifies the status of the PIP (all, open, closed, error).

PIP Instance Selection Criteria Dialog Box
This diagram illustrates the PIP Instance Selection Criteria dialog box.

Part Function

Archive if more than Specifies the age (in days) of the PIP Instance files to be archived.
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Part Function

With a Status of Indicates the status of the PIP instance files to be archived.

v All

v Open

v Closed

v Errored

PIP Instance Search Dialog Box
The following table describes the parts of the PIP Instance Search dialog box.

Part Function

Created Between Defines a range of dates and times (in local time) that designate
when a PIP instance archive was created, for which you want the
system to search.

Format: Use YYYY/MM/DD format for dates and HH:MM:SS
format for times.
Note: Click the arrow to access the calendar control.

Partner Indicates the trading partner for which to search.

Direction Indicates the direction of the PIP:

v All

v Received

v Sent

PIP Name Specifies the name of the PIP for which the system will search.

Transaction Identify
Instance ID

Specifies the transaction instance identity instance identifier for
which the system will search.

Document Name Specifies the name of the document.

Exact Match Searches for an exact match of the field, instead of a partial
match (the default).

Find Finds the appropriate PIP instances based on the criteria you
selected and displays them in the Search Results Dialog Box.
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Search Results Dialog Box
This diagram illustrates the Search Results dialog box, illustrating the result of a
search performed on archived PIP Instances.

The following table describes the parts of the Search Results dialog box.

Part Function

(list) Contains context-specific PIP Instance information.

Mark All Marks all items in the Search Results dialog box to be
restored.

Previous Selects the previous item in the list.
Note: This button is only enabled if you select an archive
file.

Next Selects the next item in the list.
Note: This button is only enabled if you select an archive
file.

Mark/Unmark Flags the selected item to be restored (or deselect a
previously selected item).
Note: This button is only enabled if you select an archive
file.

Creating an Archive Definition
About this task

Use this procedure to create an archive definition file.
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Procedure
1. From the appropriate area of The Desk, select Archive.

The system displays the Archive Manager.
2. Expand the Archive tree.

This is necessary to create a new archive definition.
3. Right-click Definitions and select New to define archive parameters.

The system displays the PIP Archive Definition Dialog Box.
4. In the Name box, type the name of the archive definition.
5. To remove the data from the Sterling Gentran:Server and Sterling

Gentran:Server for RosettaNet systems after archiving it, select Delete Data
After Archive.

6. Click Add.
The system displays the appropriate Selection Criteria dialog box.

7. Complete the appropriate parameters.

Note: All dialog box elements on the Selection Criteria dialog boxes are
automatically set to the defaults, which results in the archival of all data.

8. Click Save.
The system exits the PIP Instance Selection Criteria dialog box.

9. Click Save on the appropriate Archive Definition dialog box.
The system creates an archive definition file that contains the archive
parameters. The definition file is stored with an .ARD extension.

10. If you want to edit the archive criteria, select the appropriate item on the PIP
Archive Definition dialog box and click Edit.

11. If you want to delete archive criteria, select the appropriate item on the PIP
Archive Definition dialog box and click Delete.

Archiving Data
Before you begin

Before archiving data, you must create an archive definition file that contains your
selection criteria. Use your company’s computer backup process to back up the
Sterling Gentran:Server and Sterling Gentran:Server for RosettaNet systems before
executing the archive process. See Creating an Archive Definition for more
information.

About this task

Use this procedure to archive data.

Procedure
1. From the appropriate area of The Desk, select Archive.

The system displays the Archive Manager.
2. Expand the archive tree and open the PIP Instance Definitions folder.
3. Right-click the PIP Instance archive definition and select Archive Data.

Note: The system naming convention for creating the archive files uses the
same name of the archive definition file, plus the unique date and time of
archival, with an .ARV file extension.
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v The system executes the archive process. An interactive progress dialog box
informs you of the current state of the archive process and enables you to
cancel the archive, if necessary.

v The system archives the data by the parameters you specified and creates a
new file in the Archives folder.

4. When the archive process is complete, right-click the PIP Instance Archive
folder in the Archive Manager tree view and select Refresh.
The system displays the archive file along with the date and time on which the
archive data file was created.

Viewing Archived Data
About this task

Use this procedure to view archived information.

Procedure
1. From the appropriate area of The Desk, select Archive.

The system displays the Archive Manager.
2. Expand the archive tree and open the PIP Instance Archives folder.
3. In the Archive folder, locate the archive data file for which you want to view

the contents (summary or detailed) or search for a specific piece of data, and
click the "+" to the left of that file.
The system displays the archived files. When you select an archive file, the
system displays summary information for each item.

4. Do one of the following:
v To view the archive file information (displayed in the Archive Manager,

upper-right pane), select the archive file.
v To view the PIP Instance information (displayed in the Archive Manager,

upper-right pane), select the PIP Instance file.
The system displays the information you requested.

Searching Archived Data
The Archive Manager Search facility enables you to quickly define parameters that
are used to search all archive files or one archive file, and find a specific piece of
information. You can then select the desired information and the system highlights
it in the Archive Manager tree view.

About this task

Use this procedure to search for a specific piece of archived data.

Procedure
1. From the appropriate area of The Desk, select Archive.

The system displays the Archive Manager.
2. From the Archive Subsystem tree, select the PIP Instance Archives folder.
3. Select Archives > Search > PIP Instance.

The system displays the PIP Instance Search Dialog Box.
4. Select the appropriate parameters.
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Note: If you do not change any parameters on a search dialog box, the system
finds the default (all items).

5. Click Find to execute the search.
The system displays the Search Results Dialog Box.

6. Click Close to exit the Search Results dialog box.

About the Restore Feature
The Restore feature enables you restore archived data to the system, so you can
then view that data via the PIP Instance Viewer. When data is restored, the archive
data file (*.ARV file) is not altered and you can restore data from the same archive
file again, if necessary.

You can only restore data that was deleted after it was archived.

As the number of archive data files created by the Archive function increases and
corresponding disk space is used, you may determine that you want to move
archive data files to tape.

Copying archive files to external media is not part of the Sterling Gentran:Server
functionality. If you move an archive file to an external media, the Archive Search
facility is no longer aware of the existence of the file, and files that are moved to
an external media cannot be viewed while they reside on the external media.
However, if you reload an archive file from the external media to the Archives
folder, you can once again view the data via the Archive Manager.

Important: Use some type of management system to track the archive files saved
to external media.

Restoring Archived Data
About this task

Use this procedure to restore archived data.

Procedure
1. From the appropriate area of The Desk, select Archive.

The system displays the Archive Manager.
2. Expand the archive tree and locate the PIP Instance archive item that you want

to restore.
3. Right-click the item and select Mark\Unmark.

The system flags that item for restoration.
4. Click Restore Data.

The marked data is restored to your system and you can view it through the
PIP Instance Viewer.

Note: If the system is unable to restore data, you are prompted to view the
Audit Log for detailed information on why the failure occurred. See the IBM
Sterling Gentran:Server for Microsoft Windows Administration Guide for more
information on using the Audit Log.
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Chapter 8. Database Table Layouts

About Database Tables
Sterling Gentran:Server for RosettaNet creates the following database tables:
v PartnerContactInfo_tb
v PIPDef_tb
v PIPProfile_tb
v PIPTrack_tb

Sterling Gentran:Server enables you to access its relational database tables by using
your database management system. This gives you the capability to query the
database tables.

Important: The relationships between the tables are extremely complex, and
therefore we strongly recommend that you do not attempt to manually update
these tables.

PartnerContactInfo_tb
PartnerContactInfo_tb contains information from the Partner Contact Information
Manager.

The following table contains the field information for the PartnerContactInfo_tb.

Field Name Type Size Usage

EDICode string 255 This is the EDI Code for the selected partner.

FromContactName string 255 This is the contact name for the selected partner.

FromEmailAddress string 255 This is the E-mail address for the selected partner.

FromTelephoneNumber string 255 This is the telephone number for the selected partner.

FromFaxNumber string 255 This is the fax number for the selected partner.

FromSupplyChainCode string 255 This is the code for the global supply chain code. The
applicable RosettaNet codes are listed in the Service
Header Guideline.

FromPartner
ClassificationCode

string 255 This is the classification code for the "from" partner.
The applicable RosettaNet codes are listed in the
Service Header Guideline.

ToContactName string 255 This is the name of the "to" contact.

ToEmailAddress string 255 This is the E-Mail address of the "to" contact.

ToTelephoneNumber string 255 This is the telephone number of the "to" contact.

ToFaxNumber string 255 This is the fax number of the "to" contact.

ToSupplyChainCode string 255 This is the code for the global supply chain code. The
applicable RosettaNet codes are listed in the Service
Header Guideline.

ToPartner ClassificationCode string 255 This is the classification code for the "to" partner. The
applicable RosettaNet codes are listed in the Service
Header Guideline.
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PIPDef_tb
The PIPDef_tb is a static table that contains all the available PIPs defined by the
RosettaNet standard, including the messages within each PIP, retry counts, and
time settings. This information is used to display default information in the PIP
Profiler.

The following table contains the field information for the PIPDef_tb.

Field Name Type Size Usage

RNIFVersion string 20 This is the RNIF version number.

PIPName string 15 This is the name of the PIP.

PIPVersion string 100 This is the version of PIP within
RosettaNet.

Step number
(long)

4 This is the message’s step number in the
flow of the PIP.

DocumentName string 255 This is the message name.

SentBy string 1 This indicates whether the message is
sent by an initiator (I) or a responder (R).

DependentStep number
(long)

4 This is the PIP step number on which the
time to respond is based.

Timeout number
(long)

4 This is the time lag (in minutes) allotted
to respond to the message.

MaxRetries number
(long)

4 This is the number of times to attempt to
resend the message.

EncryptionContent string 10 This indicates the encryption content:

v None

v P - Payload

v PC - Payload Container

EncryptionAlgorithm string 20 This indicates the algorithm for
encryption:

v None

v TripleDES

v RC2

Signature string 1 This indicates whether a digital signature
is used with this message.

LastStep string 1 This indicates that this is the last step in
the PIP process.

Y indicates that it is the last step and N
indicates it is not the last step.

PIPProfile_tb
The PIPProfile_tb contains the PIPs from the PIPDef_tb that you have customized
for use at your site. This customization includes relating each PIP to a specific
trading partner, and customizing retry counts, time settings, and which messages
are used. The system (PIP Monitor and the RosettaNet Delivery Agent) compliance
checks inbound and outbound messages against the PIPProfile_tb.

The following table contains the field information for the PIPProfile_tb.
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Field Name Type Size Usage

RNIFVersion string 20 This is the RNIF version number.

PartnerName string 40 This is the name of the trading partner.

PIPName string 15 This is the name of the PIP.

PIPVersion string 100 This is the version of the PIP within
RosettaNet.

Role string 1 This indicates whether you are initiating
(I) this PIP or responding (R) to a PIP
from your partner.

Step number
(long)

4 This is the sequence number of the
message in the PIP.

DocumentName string 255 This is the message name.

Direction string 1 This indicates whether the message was
sent (S) or received (R).

DependentStep number
(long)

4 This is the PIP step number on which the
time to respond is based.

Timeout number
(long)

4 This is the time lag (in minutes) allotted
to respond to the message.

Warning number
(long)

4 This specifies the warning threshold for
this message.

MaxRetries number
(long)

4 This is the number of times to attempt to
resend the message.

EncryptionContent string 10 This indicates the encryption content:

v None

v P - Payload

v PC - Payload Container

EncryptionAlgorithm string 20 This indicates the algorithm for
encryption:

v None

v TripleDES

v RC2

Signature string 1 This indicates whether a digital signature
is used with this message.

LastStep string 1 This indicates that this is the last step in
the PIP process.

Y indicates that it is the last step and N
indicates it is not the last step.

PIPTrack_tb
The PIPTrack_tb contains all the information necessary to track a PIP through the
Sterling Gentran:Server for RosettaNet creates these database tables: system. This
table has a record for every time an inbound or outbound message is initiated
within a PIP. The information in this table is derived from the message preamble,
delivery header (for RNIF 2.0 messages only), and service header. The initial row is
created when a message is received (inbound or outbound), and after the row is
initialized the system looks up information pertaining to the PIP message and
updates the row accordingly.
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The system receives an inbound purchase order from a customer, and the system
builds a row for the message in the PIPTrack_tb. When a PIP message is passed
inbound or outbound, the system searches for the keys to the message. If the keys
are located the system updates the row in this table with the data from the service
header of the messages.

The following table contains the field information for the PIPTrack_tb.

Field Name Type Size Usage

PIPTrackKey number (long) 4 This is the PIP tracking number from the registry.

DateTimeStamp string 20 This is the date and time the message was created.

PIPName string 15 This is the name of the PIP.

PIPIID string 255 This is the identifier for the PIP.

DocumentName string 255 This is the name of the message.

DocumentIID string 255 This is the message identifier.

InterchangeKEY number (long) 4 This is a unique identifier for an interchange that is
allocated by the system.

Direction string 1 This indicates whether the message was sent (S) or
received (R).

Role string 1 This indicates whether you are initiating (I) this PIP
or responding (R) to a PIP from your partner.

AttemptCount number (long) 4 Number of times a message was sent.

PIPInstanceStatus string 1 This is the status of the PIP:

v O - Open (In Progress)

v C - Completed

v E - Error

v W - Warning

ToPartnerName string 40 This is the name of the partner receiving the PIP.

ToPartnerID string 255 This is the DUNS number of the partner receiving
the PIP.

FromPartnerName string 40 This is the name of the partner sending the PIP.

FromPartnerID string 255 This is the DUNS number of the partner sending the
PIP.

InReplyToDocName string 100 This indicates the action to which the message is
responding.
Note: This is only used with response messages.

InReplyToDocID string 255 This is a unique identifier for the response message.

ActionSignalIdentifier string 1 This indicates whether a message is an action (A) or
a signal (S).

PIPVersion string 100 This is the version of the PIP within RosettaNet.

RNIFVersion string 20 This is the RNIF version number.

ProprietaryDocID string 255 This indicates the identifier for the proprietary
(customized) message.

GenerationDate TimeStamp string 20 This is the date and time the message was generated.

Agency string 11 This indicates the standard that is used.

NumOfAttachments number (long) 4 This specifies the number of attachments.

AffirmationIndicator string 3 This indicates (Yes/No) whether secure transport is
required.
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Field Name Type Size Usage

BusinessActivityID string 255 This is an identifier that specifies a business activity.

ToPartnerDomain string 50 This is the domain type of the receiving partner.

ToPartnerLocationID string 255 This is the logical business location of the receiving
partner.

FromPartnerDomain string 50 This is the domain type of the sending partner.

FromPartnerLocationID string 255 This is the logical business location of the receiving
partner.

FromRoleClassCode string 100 This is a code used to describe the role of the partner
sending the PIP.

FromServiceCode string 100 This is the code used to describe the service the
sending partner is performing.

ToRoleClassCode string 100 This is a code used to describe the role of the partner
receiving the PIP.

ToServiceCode string 100 This is a code used to describe the service the
receiving partner is performing.

InReplytoMsgStandard string 255 This is the model of authority to which this message
is replying.
Note: A value is only necessary for non-RosettaNet
standards.

InReplyto StandardVersion string 255 This is the version of the message standard to which
this message is replying.
Note: A value is only necessary for non-RosettaNet
standards.

MessageStandard string 255 This is the model of authority used to create the
message.
Note: A value is only necessary for non-RosettaNet
standards.

StandardVersion string 255 This is the version of the message standard used to
create the message.
Note: A value is only necessary for non-RosettaNet
standards.

DocumentVersion string 255 This is a unique identifier specifying the version of
the message.

GlobalUsageCode string 15 This is the test/production flag.

PIPPayloadBindingID string 255 This is the agreed-upon identifier that indicates the
type of payload included as part of this message.

InitPartnerName string 40 This is the name of the partner initiating the PIP.

InitPartnerID string 255 This is the DUNS number of the partner initiating the
PIP.

InitPartnerDomain string 50 This is the domain type of the partner initiating the
PIP.

InitPartnerLocationID string 255 This is the logical business location of the partner
initiating the PIP.

UnknownInitPartnerURL string 255 This is the URL of the partner initiating the PIP
without a trading partner agreement.

MessageHash string 40 This is the value used to verify the integrity of the
data.

MessageHashAlgorithm string 4 This is an algorithm used to calculate the message
hash value.
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Field Name Type Size Usage

TransactionIdentityIID string 255 This is a unique identifier used to identify a business
transaction.

GlobalDocument
FunctionCode

string 50 This indicates whether the message is a "Request" or
"Response."

FromPartnerClassCode string 100 This is the code used to describe the function of the
partner sending the PIP.

ToPartnerClassCode string 100 This is the code used to describe the function of the
partner receiving the PIP.

GlobalProcessCode string 100 This is the RosettaNet-defined code that describes the
message type.
Note: This code is taken from the message service
header.

TimeToAckAcceptance string 20 This is the timeout period for acknowledging
acceptance of a message.

TimetoAckReceipt string 20 The timeout period for acknowledging receipt of a
message.

TimeToPerform string 20 This is the timeout period that an initiating business
activity will wait for a responding activity to process
a business document.
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Chapter 9. Sterling Gentran:Server for RosettaNet Error
Messages

About Sterling Gentran:Server for RosettaNet Error Messages
The Sterling Gentran:Server for RosettaNet error messages and other informational
messages are noted on the Audit Log.

Note: See the IBM Sterling Gentran:Server for Microsoft Windows Administration Guide
for more information about the Audit Log and other error messages.

The informational messages are dependent on the context of the program, and are
intended to be self-explanatory.

The following are the types of error messages that Sterling Gentran:Server for
RosettaNet uses:
v PIP Instance Viewer if the error was noted by the PIP Instance Viewer
v PIP Monitor if the error was noted by the PIP Monitor
v PIP Profiler if the error was noted by the PIP Profiler
v SCRNIFDocument if the error was noted by SCRNIFDocument
v RN20Agent if the error was noted by the RosettaNet delivery agent
v RNMgmtConsole if the error was noted by the RosettaNet Management Console
v PIP Profiler if the error was noted by the PIP Profiler
v SCRException if the error was noted by SCRException

This table lists the numeric values for the Sterling Gentran:Server for RosettaNet
message source and component values.

Source Component

4 - RosettaNet 3 - PIP Instance Viewer

4 - PIP Monitor

5 - PIP Profiler

10 - SCRNIF2Document

11 - RN20Agent

12 - RNMgmtConsole

13 - SCRException
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PIP Monitor Error Messages
This topic describes the error messages that the PIP Monitor writes to the Audit
Log.

The following table describes the PIP Monitor error messages.

Msg ID Message Text Explanation Your Action

4-4-1 Response to receive message
failed. For partner [partner name]
with Transaction Control Instance
Identifier [transaction control
instance identifier number] from
PIP [PIP name].

The specified response message
you sent failed.

Verify that you have set up
functional acknowledgements for
the outbound relationship for this
partner.

See Using Partners in the IBM
Sterling Gentran:Server for
Microsoft Windows User Guide for
more information on setting up
functional acknowledgements.

4-4-2 Exceeded maximum retry count
for message with Transaction
Control Instance Identifier
[transaction control instance
identifier number] from partner
[partner name] from PIP [PIP
name].

The specified message for the
specified partner and PIP was
sent the maximum number of
times.

Follow the RosettaNet OA1
Notification of Failure procedure.

See the RosettaNet guidelines for
usage information.

4-4-6 A database error occurred while
[the database operation that was
running]. [database error text]

An error occurred while
attempting to perform an
operation on the Sterling
Gentran:Server database.

Restart the PIP Monitor service.

4-4-7 An unknown error occurred
which prevents the PIP Monitor
Service from starting.

Unknown fatal error; PIP monitor
service cannot start.

Check the Microsoft Windows
Event Log for service start errors.
There may be a permissions
problem.

See your Microsoft Windows
documentation for more
information on checking the
Event Log.

4-4-8 The PIP profile table step
dependency query failed for
document [document name],
RNIF version [RNIF version],
partner [partner name], PIP [PIP
name], PIP version [PIP version],
role [role].

The PIPProfile_tb database table
is in error or the database is not
functioning properly.

Ensure that the PIPProfile_tb
database table is intact and that
the database is running. You may
need to restart the PIP Monitor
Service.

4-4-9 A unknown critical error occurred
causing the PIP Monitor Service
to stop monitoring PIPs.

This is a fatal error. A restart of Sterling
Gentran:Server services, a restart
of the PIP Monitor Service,
and/or a reboot of the system
may be required.

4-4-11 A database error occurred while
attempting to update the status of
all PIP instance documents for
PIPIID [PIP IID].

The status update did not occur
due to a database error.

Your Action Ensure that the
PIPTrack_tb database table is
intact and that the database is
running. May need to restart PIP
Monitor Service
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Msg ID Message Text Explanation Your Action

4-4-12 Attempt to resend document with
IID [document IID] for PIP [PIP
name], PIPIID [PIP IID],
interchange key [interchange key]
failed.

Document resend failed. Ensure that the Sterling
Gentran:Server services are
running. If they are, restart the
Sterling Gentran:Server services.

4-4-13 Unable to determine the
Gentran:Server system name or
Gentran:Server server name.
Make sure that the
Gentran:Server services are
running.

Could not determine Sterling
Gentran:Server system name or
server name. Sterling
Gentran:Server services may not
be running.

Ensure that the Sterling
Gentran:Server services are
running.

See the IBM Sterling
Gentran:Server for Microsoft
Windows Administration Guide for
more information on stopping
and starting Sterling
Gentran:Server Services.

4-4-14 Unable to initiate PIP 0A1 -
Notification of Failure for PIP
[PIP name], PIPIID [PIP IID].

An error occurred while
attempting to initiate PIP 0A1
Notification of Failure. 0A1 will
not be sent.

Ensure that the Sterling
Gentran:Server services are
running.

See the IBM Sterling
Gentran:Server for Microsoft
Windows Administration Guide for
more information on stopping
and starting Sterling
Gentran:Server Services.

4-4-15 No responding action document
was received for the document
with IID [Document IID] for PIP
[PIP Name], PIPIID [PIP IID].

PIP is now in error because no
responding action document was
received within the timeout
period.

No action required.

4-4-16 The PIP [PIP Name] [document
name] document (PIP IID [PIP
IID], Document IID [document
IID]) being sent to [trading
partner name] has been errored
since mailbox message [mailbox
message] failed to get sent.

The PIP instance is in error
because it was not sent.

Verify that IIS is running.

SCRNIF2Document Error Messages
This topic describes the error messages that the SCRNIF2Document program writes
to the Audit Log.

See the IBM Sterling Gentran:Server for Microsoft Windows Administration Guide for
more information on the audit log. Also see the Using Security Profile Manager and
Communications Tasks section for more information.

The following table describes the SCRNIF2Document program error messages.

Msg ID Message Text Explanation Your Action

4-10-4 The [XML document name] is
invalid. XML parsing results:
[MSXML parsing error
information].

The XML being loaded is invalid.
The incoming document from the
trading partner is invalid and
will be ignored.

None.
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Msg ID Message Text Explanation Your Action

4-10-5 The [name of the RosettaNet
business message piece] MIME
type is invalid. It should be
application/XML.

The incoming document from the
trading partner is invalid and
will be ignored/discarded.

None.

4-10-6 The x-RN-Response-Type MIME
header value is invalid. It must
be sync or async.

The incoming document from the
trading partner is invalid and
will be ignored/discarded.

None.

4-10-7 The x-RosettaNet-Version MIME
header is missing.

The incoming document from the
trading partner is invalid and
will be ignored/discarded.

None.

4-10-8 The x-RosettaNet-Version MIME
header value is invalid. It must
be RosettaNet/02.00.

The incoming document from the
trading partner is invalid and
will be ignored/discarded.

None.

4-10-9 One or more of the MIME body
parts is missing the required
Content-ID MIME header.

The incoming document from the
trading partner is invalid and
will be ignored/discarded.

None.

4-10-10 The [name of the RosettaNet
message piece] is missing or
contains an invalid
Content-Location MIME header.

The incoming document from the
trading partner is invalid and
will be ignored/discarded.

None.

4-10-11 The [name of the RosettaNet
message piece] MIME type is
invalid. It should be
application/XML or
application/pkcs7-mime.

The incoming document from the
trading partner is invalid and
will be ignored/discarded.

None.

4-10-12 The digital signature is missing
or its length is not valid.

The incoming document from the
trading partner is invalid and
will be ignored/discarded.

None.

4-10-13 The MIME structure does not
conform to the RNIF [RNIF
version] specification.

The incoming document from the
trading partner is invalid and
will be ignored/discarded.

None.

4-10-14 The attachment count does not
match the number of attachment
elements in the Service Header
manifest.

The incoming document from the
trading partner is invalid. An
exception document will be sent
back to the trading partner.

None.

4-10-15 The attachment count does not
match the number of attachments
in the MIME message.

The incoming document from the
trading partner is invalid. An
exception document will be sent
back to the trading partner.

None.

4-10-16 The content types for one or
more of the attachment elements
in the Service Header manifest
do not match the attachment
Content-Type MIME headers.

The incoming document from the
trading partner is invalid. An
exception document will be sent
back to the trading partner.

None.

4-10-17 The content IDs for one or more
of the attachment elements in the
Service Header manifest do not
match the attachment Content-ID
MIME headers.

The incoming document from the
trading partner is invalid. An
exception document will be sent
back to the trading partner.

None.
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Msg ID Message Text Explanation Your Action

4-10-18 The manifest in the Service
Header indicates that this
message should include
attachments but the attachments
are missing from the MIME
message.

The incoming document from the
trading partner is invalid. An
exception document will be sent
back to the trading partner.

None.

4-10-19 Unable to open the Microsoft
Enhanced Cryptographic
Provider v1.0.

Encrypted content cannot be
decrypted. The incoming
document will be
ignored/discarded.

Check the security profile
configuration for the partner.

4-10-20 Unable to open the local machine
based RosettaNet digital
certificate store.

Fatal error. This store is created
by the operating system.

Check the installation of your
operating system.

4-10-21 Decryption of the payload or
payload container failed due to
an unknown error.

Fatal error. This store is created
by the operating system.

Check the installation of your
operating system.

4-10-22 Decryption of the payload or
payload container failed because
the encrypted data is not an
enveloped cryptographic
message.

Encrypted content cannot be
decrypted. The incoming
document will be
ignored/discarded.

None.

4-10-23 Decryption of the payload or
payload container failed because
the encrypted data uses an
unsupported encryption
algorithm.

Encrypted content cannot be
decrypted. The incoming
document will be
ignored/discarded.

None.

4-10-24 Decryption of the payload or
payload container failed because
no partner certificate was found
having a private key to use for
decrypting.

Encrypted content cannot be
decrypted. The incoming
document will be
ignored/discarded.

None.

4-10-25 Encryption of the payload or
payload container failed due to
an unknown error.

Content cannot be encrypted. The
outgoing document will be not
be sent to the trading partner.

Check the security profile
configuration for the partner.

4-10-26 Encryption of the payload or
payload container failed because
the public certificate for the
recipient could not be found or
the public certificate for the
recipient does not allow
encryption.

Content cannot be encrypted. The
outgoing document will be not
be sent to the trading partner.

Check the security profile
configuration for the partner.

4-10-27 Digital signing of the RosettaNet
message failed due to an
unknown error.

The outgoing document cannot
be digitally signed. It will not be
sent to the trading partner.

Check the security profile
configuration for the partner.

4-10-28 Digital signing of the RosettaNet
message failed because the
certificate did not have a private
key to use for signing.

The outgoing document cannot
be digitally signed. It will not be
sent to the trading partner.

Check the security profile
configuration for the partner.

4-10-29 Digital signing of the RosettaNet
message failed because the
signing certificate could not be
found in the SCROSETTANET
certificate store.

The outgoing document cannot
be digitally signed. It will not be
sent to the trading partner.

Check the security profile
configuration for the partner.
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4-10-30 Digital signature verification
failed due to an unknown error.

The digital signature cannot be
verified. The incoming document
will be ignored/discarded.

Check the security profile
configuration for the partner.

4-10-31 Digital signature verification
failed because the digital
signature is not a signed
cryptographic message.

The digital signature cannot be
verified. The incoming document
will be ignored/discarded.

None.

4-10-32 Digital signature verification
failed because the RosettaNet
message was hashed and signed
using an unsupported algorithm.

The digital signature cannot be
verified. The incoming document
will be ignored/discarded.

None.

4-10-33 Digital signature is not valid for
this RosettaNet message.

The digital signature cannot be
verified. The incoming document
will be ignored/discarded.

None.

4-10-34 Message hash creation failed.
Non-repudiation of receipt will
not be possible.

A message hash will not be sent
to the trading partner when the
response to this incoming
document is sent.

None.

4-10-35 The merged XML data containing
the new outbound RosettaNet
message is invalid. XML parsing
results: [parsing error details].

An outbound document cannot
be created using this XML.

Check your outbound document
maps.

4-10-36 An unknown fatal error caused
outbound RNIF [RNIF version]
document creation to fail.

Fatal error. Call support.

4-10-37 The key store containing the
required private key failed to
open. The encrypted content
cannot be decrypted.

The encrypted content cannot be
decrypted. The incoming
document will be
ignored/discarded.

Check the security profile
configuration for the partner.

4-10-38 The key store containing the
required private key failed to
open. The content cannot be
digitally signed.

The outgoing document will not
be sent to the trading partner.

Check the security profile
configuration for the partner.

4-10-39 The security profile does allow
the partner certificate to decrypt
this message. The encrypted
content cannot be decrypted.

The encrypted content cannot be
decrypted. The incoming
document will be
ignored/discarded.

Check the security profile
configuration for the partner.

4-10-40 Digital signature verification
failed because the receiving
partner certificate was not used
to sign the message.

The digital signature cannot be
verified. The incoming document
will be ignored/discarded.

Check the security profile
configuration for the partner.

4-10-41 The outbound RosettaNet
message cannot be created
because the attachment count
information in the outbound
XML data is invalid.

An outbound document cannot
be created using this XML.

Check your outbound document
maps.

4-10-42 The outbound RosettaNet
message cannot be created
because the attachment
information in the outbound
XML data is invalid.

An outbound document cannot
be created using this XML.

Check your outbound document
maps.
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4-10-43 The outbound RosettaNet
message cannot be created
because one or more of the
attachment files in the outbound
XML data cannot be opened or
read.

An outbound document cannot
be created using this XML.

Check your outbound document
maps.

4-10-44 The data being loaded is not
valid RosettaNet data.

The data being loaded does not
contain valid RNIF 1.1 or RNIF
2.0 data.

None.

4-10-48 The incoming data contains
invalid RNIF 1.1 version
information.

The RNIF 1.1 data contains
invalid version information. The
document will be
discarded/ignored.

None.

4-10-49 The outbound merged XML data
contains an invalid root tag.

The root tag indicates the RNIF
version. It must indicate 1.1 or
2.0.

None.

4-10-50 Digital signature verification
failed because the public key
certificate for the sending partner
was not found.

The public key certificate needed
to verify the signature was not
found in the RosettaNet
certificate.

Ask the sending partner for a
copy of the public key certificate.

RN20Agent Error Messages
This topic describes the error messages that the Delivery Agent writes to the Audit
Log.

See "Using the Audit Notification System" in the IBM Sterling Gentran:Server for
Microsoft Windows Administration Guide for more information on the audit log. Also
see the Using the PIP Profiler section for more information.

The following table describes the Delivery Agent error messages.

Msg ID Message Text Explanation Your Action

4-11-100 Invalid option parameter
specified. Delivery agent
processing cannot continue.

"Inbound" and "Outbound" are
the only valid parameters.

Ensure that the delivery rule is
not mistyped.

4-11-103 Delivery agent failed to process
attachment [Mailbox attachment
ID] for message [Mailbox
message ID].

An "end" message that bookends
one attachment processing
session, and you should get an
audit error message before it.

Follow the instructions listed in
this appendix for the error
message that precedes this one.

4-11-104 Could not get attachment(s) for
message [Mailbox message ID].
Delivery agent processing cannot
continue. Mailbox error code
returned: [Mercury error code]

Mailbox API error. Call support.

4-11-105 Could not delete attachment
[Mailbox attachment ID] for
message [Mailbox message ID].
Delivery agent processing cannot
continue. Mailbox error code
returned: [mailbox error code] =
Mercury error code.

Mailbox API error. Call support.
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4-11-106 An exception occurred while
processing attachment [Mailbox
attachment ID] for message
[Mailbox message ID]. Delivery
agent processing cannot
continue. Error message:
[CException error text]

A MFC CException occurred
while opening or closing the
attachment.

Call support.

4-11-1000 A file exception occurred while
accessing an attachment. Error
returned: [CFileException error
text]

A MFC CFileException occurred
while accessing the attachment.

Call support.

4-11-1001 An error occurred while
processing the attachment. [error
text (e.g., "The attachment has
an invalid file length.") ]

Depending on the error
indicated, either the attachment
is empty or a Win32 API or MFC
error occurred while performing
the task indicated.

Call support.

4-11-1002 Could not create a new copy of
attachment [Mailbox attachment
ID] for message [Mailbox
message ID]. Mailbox error code
returned: [mailbox error code]

Mailbox API error. Call support.

4-11-1003 An exception occurred while
processing attachment [Mailbox
attachment ID] for message
[Mailbox message ID]. Error
message: [CException error text]

A MFC CException occurred
while opening or closing the
attachment as a stream.

Call support.

4-11-1004 Could not delete mailbox
message [Mailbox message ID to
be deleted] associated with
attachment [Mailbox attachment
ID] for message [Mailbox
message ID]. Mailbox error code
returned: [mailbox error code]

Mailbox API error. Call support.

4-11-1005 A file exception occurred while
accessing the interchange file
[interchange filename]. Error
returned: [FileException error
text]

A MFC CFileException occurred
while accessing an interchange
file.

Call support.

4-11-1100 A database error occurred while
[task (e.g., "querying the
database")]. [error text (e.g.,
"Can't create the recordset.")]

Depending on the error
indicated, either database access
info is missing from the registry
or a MFC CDatabase/
CRecordset error occurred while
accessing the database.

Call support.

4-11-1101 A database exception occurred
while [task (e.g., "querying the
database")]. Error returned:
[CDBException error text]

A MFC CDBException occurred
while accessing the database.

Call support.

4-11-1102 An exception occurred while
[task (e.g., "querying the
database")]. Error returned:
[CException error text]

A MFC CException occurred
while accessing the database.

Call support.
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4-11-1103 Could not find the partner EDI
code ["partner EDI code"] in the
database.

No partner with that EDI code
was found in the Partner_tb
database table.

Check the EDI code for the
partner in question. Verify the
EDI Code in the partner
definition you created. This EDI
code must match the valued
entered in the Sender box on the
Outbound Envelope PIP
Initiation dialog box.

4-11-1104 An instance with PIPTrackKey
[PIPTrackKey] already exists in
the database. Unable to insert
[document name] document
[document IID] from [trading
partner name].

Could not save the new PIP
instance data to the PIPTrack_tb
database table because the
primary key number allocated
by the Executive Service already
is already being used in that
table.

Restart services and try again. If
this is unsuccessful, call support.

4-11-1105 A(n) [role ("initiating" or
"responding"] PIP [PIP name]
profile (PIP version [PIP version]
for RNIF [RNIF version]) was
not found for either [trading
partner name] or "["Any"
keyword ]" partner. The partner
is not authorized to do this PIP.

No matching PIP profile entry
was found in the PIPProfile_tb
database table

Create a PIP profile for the PIP
and partner in question.

4-11-1106 An error occurred while [task
(e.g., "querying the database")].
[error text (e.g., "Could not find
the signal document.")

This message is used for a
variety of errors and will only
appear in very unlikely
scenarios, such as deleting or
modifying PIP documents or
profiles while the delivery agent
is accessing that data.

Call support.

4-11-1107 PIP [PIP name] version [PIP
version] instance [PIP IID] being
traded with [trading partner
name] is not in order.

The documents in this PIP set
are not in the proper sequence
when compared to the document
order in the corresponding PIP
profile.

Make sure the documents are
sent and received in the order
specified in the PIP profile.

4-11-1108 A security violation was
encountered with a [document
name] document for PIP [PIP
name] version [PIP version]
instance [PIP IID] being traded
with [trading partner name].
[security violation type].

The security properties of the
inbound document do not match
the security settings in the
corresponding PIP profile.

Make sure the security
properties of the document and
the PIP profile match.

4-11-1109 A [document name] document
for PIP [PIP name] version [PIP
version] instance [PIP IID] being
traded with [trading partner
name] arrived late since the
corresponding [parent action
document name] document has
already timed out and is being
resent.

The inbound signal document
arrived too late to be considered
a valid acknowledgement since
its parent action document is
being resent.

Wait for the resend process to
complete. The signal document
will eventually be resent by the
trading partner.
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Msg ID Message Text Explanation Your Action

4-11-1111 A [document name] document
was received from [trading
partner name] for PIP [PIP
name] version [PIP version]
instance [PIP IID] since the
[parent action document name]
document that we sent is bad
(and will be errored).

An inbound exception document
was received because you sent a
bad action document.

Check all maps to ensure that a
valid document is being sent.

4-11-1112 A [document name] document
was received from [partner
name]. There is a problem with
the [document name of bad
document] document belonging
to PIP [PIP name of bad
document] version [PIP version
of bad document] instance [PIP
IID of bad document]. That PIP
will be errored.

The trading partner did not
receive a response from you
after sending an action
document and thus initiated a
PIP 0A1 document since the
retry attempts for the action
document have been exceeded.

Make sure there are no
communications, network, or
system problems. Check your
map and partner settings to
ensure a proper response
document can be generated. Call
support if necessary.

4-11-1113 The document name "[document
name of first instance]" of the
initiating instance for PIP [PIP
name] version [PIP version]
instance [PIP IID] being traded
with [trading partner name]
does not match any document
name in the corresponding
profile.

The document name in the data
does not match any document
name in the profile.

Check all maps to ensure that
the document name matches the
one in the PIP profile.

4-11-1114 The initiating document for PIP
[PIP name] version [PIP version]
instance [PIP IID] being traded
with [trading partner name] is
missing. The PIP set will be
errored.

The documents in this PIP set
are not in the proper sequence
when compared to the document
order in the corresponding PIP
profile.

Make sure the documents are
being sent and received in the
order specified in the PIP profile.

4-11-1115 Due to [reason for discarding
messages] message [Mailbox
message ID], this message and
all related mailbox messages will
be discarded.

Mailbox messages will be
deleted because of either a
security violation or an
exception that was generated.

Refer to the previous audit
message for further explanations
about the error.

SCRException Error Messages
This topic describes the error messages that the SCRException program writes to
the Audit Log.

See "Using the Audit Notification System" in the IBM Sterling Gentran:Server for
Microsoft Windows Administration Guide for more information on the audit log.

The following tables describes the SCRException program error messages.

Msg ID Message Text Explanation Your Action

4-13-1 Generation of merged XML for
exception failed. Reason: [reason
text indicates the type of failure
and suggests a possible course of
action]

Attempt to generate a merged
XML RNIF 2.0 exception
document failed.

Fatal error—take the course of
action suggested in the error
message and if necessary, call
support.
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Msg ID Message Text Explanation Your Action

4-13-2 [0A1 or Exception Query of the
Gentran:Server database for the
destination mailbox failed]
destination mailbox lookup
failed. Error details: [lookup
failure error details]

Query of the Sterling
Gentran:Server database for the
destination mailbox failed.

Check the Sterling
Gentran:Server mailbox
configuration.

4-13-4 Unable to send [0A1 or
Exception] to mailbox
[destination mailbox]. Mercury
error = [mailbox error].

Error occurred during exception
delivery.

Ensure that the Sterling
Gentran:Server services are
running.

4-13-5 Generation of merged XML for
PIP 0A1 initiation document
failed. Reason: [reason text
indicates the type of failure and
suggests a possible course of
action]

Attempt to generate a merged
XML RNIF 1.1 exception
document failed.

Fatal error—take the course of
action suggested in the error
message and if necessary, call
support.

Chapter 9. Sterling Gentran:Server for RosettaNet Error Messages 117



118 IBM Sterling Gentran:Server for Windows: RosettaNet User Guide



Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing

IBM Corporation

North Castle Drive

Armonk, NY 10504-1785

U.S.A.

For license inquiries regarding double-byte character set (DBCS) information,
contact the IBM Intellectual Property Department in your country or send
inquiries, in writing, to:

Intellectual Property Licensing

Legal and Intellectual Property Law

IBM Japan Ltd.

19-21, Nihonbashi-Hakozakicho, Chuo-ku

Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
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incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation

J46A/G4

555 Bailey Avenue

San Jose, CA 95141-1003

U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject
to change without notice. Dealer prices may vary.
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This information is for planning purposes only. The information herein is subject to
change before the products described become available.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows:

© IBM 2012. Portions of this code are derived from IBM Corp. Sample Programs. ©
Copyright IBM Corp. 2012.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Trademarks

IBM, the IBM logo, and ibm.com® are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at “Copyright and
trademark information” at http://www.ibm.com/legal/copytrade.shtml.

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States,
and/or other countries.

IT Infrastructure Library is a registered trademark of the Central Computer and
Telecommunications Agency which is now part of the Office of Government
Commerce.

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo,
Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or
registered trademarks of Intel Corporation or its subsidiaries in the United States
and other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.
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Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

ITIL is a registered trademark, and a registered community trademark of the Office
of Government Commerce, and is registered in the U.S. Patent and Trademark
Office.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Java™ and all Java-based trademarks and logos are trademarks or registered
trademarks of Oracle and/or its affiliates.

Cell Broadband Engine is a trademark of Sony Computer Entertainment, Inc. in the
United States, other countries, or both and is used under license therefrom.

Linear Tape-Open, LTO, the LTO Logo, Ultrium and the Ultrium Logo are
trademarks of HP, IBM Corp. and Quantum in the U.S. and other countries.

Connect Control Center®, Connect:Direct®, Connect:Enterprise®, Gentran®,
Gentran:Basic®, Gentran:Control®, Gentran:Director®, Gentran:Plus®,
Gentran:Realtime®, Gentran:Server®, Gentran:Viewpoint®, Sterling Commerce™,
Sterling Information Broker®, and Sterling Integrator® are trademarks or registered
trademarks of Sterling Commerce®, Inc., an IBM Company.

Other company, product, and service names may be trademarks or service marks
of others.
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